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Tutorials for Leapfrog Geo 4.4

These tutorials introduce basic conceptsin Leapfrog Geo, such as setting up a project,
importing and working with data and building simple geological models. Download the tutorial
data at http://help.leapfrog3d.com/Tutorials/Geo/4.4/en-GB/LeapfrogGeoTutorialData.zip.

The data for the first tutorial is a Leapfrog Geo project that includes a series of saved scenes that
are used to introduce different aspects of using Leapfrog Geo. For subsequent tutorials, you will
import data and use it to build geological models.

The tutorials are:

o Tutorial 1: Introduction to Leapfrog Geo

Tutorial 2: Modelling Veins

o Tutorial 3: Modelling a Syncline in a Series of Deposits

o Tutorial 4: Modelling a Complex Intrusion

o Tutorial 5: Building a Geological Model From a Map

When using Leapfrog Geo, you can find more information on the tools available by clicking on
the Help button that appears in many windows:

@ Mew Geological Model

General

Base lithology column: | Lithology | = |
Surface resolution: @ [ Adaptive

Model Extents
Minimum Maximum

X(Fast): [2223800.7845443 3] [2312060.5626014 3

¥ (North): [5604185.0828478 3| 5710922.8404842 |2

ZHa) (1320

Name: [GM l

ﬁﬂe\p xgancal ‘ @QK |

Pressing the F1 key also displays help for the current window.
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Tutorial 1: Introduction to Leapfrog Geo

In this tutorial, we will work through an existing Leapfrog Geo project. This project includes a
series of saved scenes that demonstrate different aspects of using Leapfrog Geo.

1. Unzip the folder that contains the tutorial data and copy it to your hard drive.

The project file for this tutorial can be found in the Introduction folder and is called “Leapfrog
Geo Tutorial”.

2. Launch Leapfrog Geo.
The main window will appear with the Projects tab displayed.

The Recent projects list is a useful way of accessing the projects you are regularly working in.
Below the Recent projects list, the Search folder is displayed. This is useful if you have one
folder in which you will keep most of your Leapfrog Geo projects. Click on the folder button (&)
to change the Search folder. When there are Leapfrog Geo projectsin the Search folder,
thumbnails for them will be displayed.

3. In the Projects tab, click Open Project File:

~ | BB Projects | B Scene View

%g Project Tree i
|_] New Project...

[~ Open Project File...

Recent projects | Clesr

4. Navigate to the folder where you saved the tutorial project files and click on the “Leapfrog
Geo Tutorial.aproj” file.

The project will be opened and Leapfrog Geo will display the Scene View tab.
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The Leapfrog Geo Main Window

The Leapfrog Geo main window is divided into three parts:

rial - Leapfrog Geo

¥ | BB Projects [ Scene View ‘
L s Al w-WNEB- [N\ 8 @ i
V¥ [ Topographies [ . -
A Topography e

P [ Draped GIS Objects
[ 3 E‘ Gls Data, Maps and Photos
V [ Drillhole Data
[ 3 ||| Drillholes
[ 3 E‘ Planned Drillholes
E‘ Drillhole Correlation

E‘ Points
E‘ Polylines
3 E‘ Structural Modelling

[ 3 E‘ Meshes
¥ [ Geclogical Models
> (7 oM
[ 3 [d Static GM
E‘ Mumeric Models
E‘ Combined Models
[ Block Models
V [ Saved Scenes and Movies
P Maps and topography @ 4 Topography

te. ® 2, Displaying drillhele data GIS data: [EAreamap |

%, ™ 3, Defining the model boundary @ @ Farmland detail

. ® 4. Slicing through a geological med| | . T
t, ™ 5, Using the moving plane

. ™ 6, Using the ruler to measure in 30
%, ® 7, Cross section with geclogical mo
[ E‘ Cross Sections and Contours
E‘ Colour Gradients

[* Motes

2310000

East (X)

Plunge +38 e
Azimuth 226

o 2500 5000 7500 10000

bk & Tekapo

oo m
: :II Slice mode: |From Scene v |

i)

B x

1 b

'8 E Full Acceleration 9FPS £ Z-Scale 20

o The Project Tree contains all the data in the project and tools for working with that data. When you
want to change how this data is used in the project, work with the objects in the project tree.

The Scene View tab displays a 3D representation of selected objects from the project tree.
o Changing how you view objects in the scene window does not change those objects in the project
tree.

Tools for changing the appearance of data in the scene window are available in the Shape List and
o the Shape Properties Panel. Changing the appearance of these objects does not change those
objects in the project tree.

The series of folders in the project tree are used to organise objects such as maps, images and
data setsinto categories. These folders also provide tools that let you import information into
the project and generate models. Right-click on each folder to view the actions you can
perform using that folder.

You can add objects to the scene window by dragging them from the project tree. You can
temporarily hide them in the scene or remove them altogether using the controls in the shape
list.
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The current viewing angle and scale are displayed in the lower right-hand corner of the scene
window. You can interact with the scene using the mouse or the keyboard:

Action Mouse Keyboard
Changing the Click and drag to rotate the Press the arrow keys to rotate the scene
viewing angle scene

For smaller steps, hold down the Shift key while
pressing the arrow keys

Zooming in and out | Use the scroll wheel Press the Page Up or Page Down keys
of the scene Hold the right mouse button For smaller steps, hold down the Shift key while
while moving the mouse pressing the Page Up or Page Down keys

Click and hold both mouse
Panning th Hol the Alt k hil ing th k
anning the scene buttons, then drag old down the ey while pressing the arrow keys

Hold the scroll wheel and drag

Click the scroll wheel
Centre an objectin

the scene Click both mouse buttons

together

Practise rotating the scene using mouse, arrows and modifier keys. The viewing angle and scale
in the lower right-hand corner of the scene window change as you rotate the scene.

% +2310000

ast ()

w W
~ Plunge +38 @
Azimuth 226

0 2500 5000 75000000

Toward the bottom of the project tree, the folder Saved Scenes and Movies contains a series of
scenes we will look at in order to understand how Leapfrog Geo projects work.

Saved scenes provide a stable point of reference in a project and can explain important
aspects of the project. Saving a scene does not save copies of the objects in the scene, it
simply saves settings relating to how the objects are displayed. Deleting objects from the
project will not preserve those objects in any saved scenes.

The project was last saved with the first scene, “1. Maps and topography”, displayed. If you have
changed the scene, you will need to redisplay the opening scene.
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1. Right-click on the “1. Maps and topography” scene in the Saved Scenes and Movies folder

and select Display:

v E‘ Saved Scenes and Movies ‘
%, ™ 1, Maps and topography
. . Open
%, ™ 2, Displaying drillhole dat
. . Display
te. ™ 3, Defining the model bo — [y
Py Slicing through a geolo
e, ® 5, Using the moving pland & Delete...
e W R licinn the rmilar tn meacura in W |

Rename..,

F2

Delete —

The scene will be updated to show a “Topography” object and two images:

- [ @ screver |

| 2 Alex Rock +

F - WN #FB-[L\# S

2310000

ast (X)

w

@

Plunge +38 e
Azimuth 226

1] 2500 5000 7500 10000

@ {4 Topography

G1S dta: [HArea map -]

<@ [ Farmland detail

& Tekapo

Slice mode: | From Scene Tl

£ . Tekapo

e Full Acceleration TEPS

& Z-5cale 20

All objects in the shape list have a button (¥) that will remove the object from the scene. Most
objects also have a visibility button () that can temporarily hide that object in the scene. It is
often easier to make an object temporarily invisible than to remove it from the list. Some objects
have an edit button (#*) that you can click to begin editing the object.

The shape list also contains options for changing the appearances of the object in the scene.
For the images, you can only change the opacity by adjusting the slider. For the topography, the

GIS data dropdown list provides additional display options.

2. Click on the GIS data dropdown and select None:

© 2018 Seequent Limited
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The scene will be updated so that the Topography object is displayed using the Flat colour
option. In the case of surfaces, different colours will be assigned to each side. The Topography
hasan “Above” colour (yellow) and a “Below” colour (grey):

@ 3 Topography ] & Flat col...~ @ v/ b
GIS data:

@ @ Farmland detail b4

- Tekapu b4

The colour used to display an object can be changed by clicking the colour chip. In the window
thatappears, you can set a new colour or select from predefined colours:

Edit Above

Py 4 Hue (23 2 Red: [255
Saturation: | 255 |+ Green: [255
‘ Value: [255 |2 Blue: [0
Colour name: | yellow ]
Palette:
H EEEE =
2 | AEN B
;;ﬂelp Random Revert wgose

Many objects can also be displayed using other available data. For example, the Topography
includes elevation data and face dip data.

3. Click on Flat colour to view other display options:

® 4 Topography 8 [&Fatcol.o [ [0 ey
GIS data: & Flatcoh%r

@ @ Farmland detail ® #.. Elevation

@ @ Tekapo 3 5 Facedip

Changing how you view objects in the scene window does not change those objects in the
project tree.
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4. Click on the (¥) button for each of the images in the shape list:

v | BB Projects QSceneV\Ew‘
G’Look-ﬁxgmv@\\gf ﬂlﬂ

+2310000

’ g

. Plunge +38 0

- i Azimuth 226

- o 2500 5000 7500
@ £ Topography 3 (@ Flat col..~ ][ |[VINM ——) b b 8| No selection
Select -
@ Q| Farmland detail b4 [ |
L E‘Tekapo :lI_I
Remove from scene
& +2312527.79, +5706711.61, +701.54 El Full Acceleration 12 FPS @Z—Sca\EE.O

Removing objects from the scene by clicking the (¥) button does not remove them from the
project.

Only the topography remainsin the scene.

The Z-Scale button in the lower right-hand corner of the main window lets you set a value
greater than 1.0 for the z-axis relative to the x- and y-axes. This is useful when the area under
study is very planar and extends over a wide area. In such cases, scaling the Z-axis can
accentuate the distribution of data along the z-axis.
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5. Click the Z-Scale button and experiment with different z-scale settings to see the effects:

* | BB Projects ﬂScEneViaw‘
;Lookvwxgm'[g.‘kg&? ﬂlﬁ

2295000

2300000

+2310000

Plunge +38 e
Azimuth 226

0 2500 5000 7500

@ 4 Topography # |&Flat col...~ l:l % bk #| No selection
GIS data: | Select -] b
\
L8 Full Acceleration 10FPS  §Z-Scale 2.0

6. Return the Z-Scale setting to 2.0.

Displaying GIS Data
The GIS data dropdown listincludes a number of GIS data objects and images that have been

imported into the project. There are three ways to view imported GIS data and images:

« Display the objectsindependently of the topography. To view data in this way, either drag
and drop the object into the scene or right-click on the object and select View Object.

« Display objectsdraped on the topography.
« Display objects as part of a custom topography view.

To display GIS data with the topography:

1. Fromthe shape list, select the GIS data dropdown list and select GIS objects, then the lake_
bdy line.
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The topography will be displayed with the GIS line draped on it using the Flat colour option:

m.f.u\glg.@§cf @ &

Plunge +38 o
Azimuth 226

] 2500 5000 7500 10000

‘QaTopography % [&Fatcol..- ik ¥ | GIS data: lake_bdy

The lake_bdy object can also be displayed using the columns available in the data table, which
can be selected from the view list:

| @ {4 Topography

XWI:I-ZIIJAB |

fis ELEVATION

& shapelD
(B, WATER_CONF

The GIS data list also contains options for creating and displaying custom topography views

‘ @ a Topography

xwzl-@us |

Mene

Views & ¥
Maps and Photos ¥

GIS objects ¥

Topography + GIS data

Topography contours

2. Click on the GIS data dropdown list and select Views, then the "Topography + GIS data”
option.
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The Topography will be displayed with map images and a number of GIS data objects draped
onit:

v [ Prjects| @ sceneview |

F - WNFB- (RN S @ &

=)
=1
=1
@
o
ol

East (X)

Plunge +38 Q
Azimuth 226

1] 2500 5000 7500 10000

= £ Topography 8 [@Fatcol.~][ | — ) pi GIS data: Topography + GIS data
GIS data: | Topography +..7 | D e— i}
—

3. Click on the GIS data dropdown list and select Views, then the Edit views option.

4. In the window that appears, experiment with adding and removing layers and changing how
they are displayed:

& Edit GIS Views

65 views: [ Topography + GIS data v | |Rename | | New...| |Delete|

Ayailable layers: Current layers:
~ North_boundary 7 rivercl & Flat colour = width: 1.00 L
57 river_bdy . river_seed & Flat colour = I:I sizer  4.00 w— 111 ]
17 lake_seed 5 lake_bdy @ Flat colour | [ width: 1.00 =]
0 river_poly 7 lake_poly & Flat colour = I:I — 11
‘-\1“ Topography contours 0 scree_poly & Flat colour ~ I:I =
0 shingle_poly & Flat colour ~ I:I e |
Farmland detail =
Tekapo o 1 |
rca mep —

Add ﬁy \; Remove ‘ J} Lower |

i Help | 9 RevertAll | | @ Close |

The scene will be updated as you make changes in the Edit GIS Views window.
5. When you have finished, click Revert All to discard your changes, then click Close.

How Objects are Organised in the Project Tree

The way folders and objects are organised in the project tree lets you reveal or hide information
about an object to focus on objects you are currently working with. Thisis also useful when you
are exploring a project and want to determine how something was put together. Leapfrog Geo
projects can be complex and the number of objects in the project tree can seem overwhelming.
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The arrows next to objectsin the project tree let you reveal or hide an object’s details to focus on
objects you are currently working with. Let's look at three objects in this project to see how this
works, the Topography object, a geological model and a static model.

In Leapfrog Geo, the topography is used to define the elevation of the ground’s surface. The
topography can be defined using a single digital terrain model (DTM), but often data from
several sources is combined to ensure the data is consistent.

The topography is used as the upper boundary for geological models and to position

GIS data. As a result, changing the topography will cause geological models to be
recomputed and GIS data to be repositioned. This can be time-consuming, which is why it is
best to define the topography before GIS data is added to the project and before any models
are created.

To determine how the topography was created, we need to find the topography in the project
tree.

1. Right-click on the Topography object in the shape list and select Go to Project Tree:

¥ | BB Projects | G Scene View {—J
F - W F M- KN\ &S S

B Goto Project Tree l}
Visible

Opacity

Slice Mode

Display

D Colour

. Back Colour

East (X)
\

Faces
[ Edges
Smooth Faces

3¢ Remove Plunge +38 Q
Azimuth 226

Remove All Invisible
o 2500 5000 75000000
. . e e —
EE Move List to Right

E Put List in Separate Tab

@ 44 Topography [ Y é Topography
GIS data m Slice mode: From Scene v

The Topography object (4) in the Topographies folder is selected:

‘Eg Project Tree

YE‘TUpUgraph\es

[ Topography

B [ Draped GIS Objects
[ E‘ GIS Data, Maps and Photos
W [ Drillhole Data

P |11 Drillholes

P [ Planned Drillholes

E" Drillhole Correlation

Objects displayed in bold in the project tree are those objects visible in the scene.

2. To see how the Topography was created, click on the arrow to expand it.
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The Topography was created from an imported DTM:

[ Leapfrog Geo Tutorial - Leapfrog Geo

?:g Project Tree i'_i-‘

¥ [ Topographies

¥ 4 Topography

& Tekapo DTM

P [ Draped GIS Objects
[ 3 E‘ GIS Data, Maps and Photos
¥ [ Drillhole Data

B ”l Drillholes

[ 3 E‘ Planned Drillholes

E‘ Drillhole Correlation

The object is hyperlinked because it is stored elsewhere in the project tree.
3. Click on the hyperlink to view the source object:

& Leapfrog Geo Tutorial - Leapfrog Geo

o Project Tree &
v E‘Tupugraphwas
v Topography
&2 Tekapo DTM
[ E‘ Draped GIS Objgcts
[ E" GIS Data, Maps and
¥ [ Drillhole Data
B 1] Drillholes
P [ Planned Drillholes
E‘ Drillhele Correlation
E" Points
E" Polylines
P [ Structural Modelling
v E‘ Meshes
&2 Tekapo DTM
v E‘ Geological Models

The imported DTM is stored in the Meshes folder.

Now let's look at the components of a geological model.

4. Click on the Clear scene button (¥).

The Geological Models folder contains a model called “GM".
5. Drag the "GM" model into the scene.

6. In the project tree, click the arrow for the model to expand it.
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7. Click the arrows for the model's Boundary, Lithologies, Surface Chronology and Output
Volumes objects.

al - Leapfrog Geo

'Eg Project Tree

¥ [ Geological Models
v (7 Gm
¥V & Boundary
(E7 GM Extents
P = Topography
P | North_boundary
&3 Fault System
v —El Lithologies
iy Lithology
v '\% Surface Chronclogy
P @ Alluvium contacts
P @ Alluvium - Coarse Sand contac
P @ Gravel - Alluvium contacts
P @ Glacial Till - Gravel contacts
P @ Lower Gravel - Glacial Till cont
[ Aquifer Miccene Alluvium - Lg
P @ Basement Granite contacts
v E‘ Qutput Volumes
& Alluvium
& Coarse Sand
& Gravel
& Glacial Till
& Lower Gravel
& Aquifer Miocene Alluvium
& Basement Granite
P [ Static GM
E‘ Mumeric Models
E‘ Combined Models
[ Block Models

-

e

v | B8 Projects [ Scene View

F - WNEE- D\ &S @ o

Morth (Y)

Plunge +20
Azimuth 030

©

0 500 1000 1500
< [{ GM 38 [[@om - Edit Colours | " =l fBam
Slice mode: |From Scene v
Fill Slicer
b @ Full Acceleration 16FPS  $pZ-Scale 2.0

The five objects underneath the geological model “"GM” represent the five basic parts of a
geological model:

The Boundary object defines the outer limits of the geological model. It is made up of a basic
“GM Extents” object, the Topography and a “North_boundary” object.

The Fault System object defines faults and their interactionsin the geological model. For
this model, no faults are defined and so the object is empty.

The Lithologies object defines the lithologies in the model. Because the model was made
from drillhole data, this object is hyperlinked to the imported drillhole data.

The Surface Chronology object defines the structure of the model's contact surfaces. The
contact surfaces are used to divide the model Boundary into the Output Volumes.

The Output Volumes folder contains the generated units (outputs) that make up the

geological model.

Expand the objects under the Boundary object to see the data used to make the extents:

W @ Boundary
(£ GM Extents
¥V — Topography
aTogograghx
v ‘ Merth_boundary
¥ ™ North_boundary vertical wall
% Morth boundary
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The Topography objectis included as the model's upper boundary. The “North_boundary”
object was created using a GIS data object in the GIS Data, Maps and Photos folder. Clicking
on the hyperlinks will locate the object from which the extent was created.

Also in the Geological Models folder is another object, called “Static GM".
9. Expand the Static GM model in the project tree:

v I‘f Static GM
:—El Legend
P & Boundary
& Fault System
P () Surface Chronclogy
[ E‘ Output Volumes

The Static GM model is made up of the same objects as the GM model, but most of these
objects cannot be edited. You can change the colours used to display the output volumes by
clicking on the Legend object.

10. Right-click on the Static GM model and select Properties.

In the window that appears, we can see the date the static model was created and information
aboutits volumes:

& Properties - Static GM

General Processing  Errors
Created On: 25/08/2018

Volumes:

Alluviurm: 679,820,000
Coarse Sand: 137,410,000
Gravel: 244,270,000
Glacial Till: 224,940,000
Lower Gravel: 646,530,000
Agquifer Miocene Alluvium: 36,217,000
Basement Granite: 1,660,600,000

The Properties window is a useful way of finding out more information about objectsin the
project. The information available in the Properties window depends on the type of object and
is available for most types of objects.

The Static GM model is a static copy of the GM model. Models in Leapfrog Geo will be updated
when changes are made to the data objects used to create them. A static copy, however, isa
snapshot of a model that does not change, even when changes are made to the data on which
the original model was dependent. A static copy is a useful way of storing historical models and
comparing models.

Exploring Additional Scenes

There are other saved scenes in the project that demonstrate different aspects of using
Leapfrog Geo, including:

« Displaying drillhole data
» Defining a model's boundary
« Using theslicer to slice objectsin the scene

« Using the moving plane to measure trends
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o Using the ruler to measure distances
« Creating and evaluating cross sections

Explore these saved scenes to see how different objects are managed in Leapfrog Geo. You can
display each saved scene by dragging it into the scene window. You can find out more about
each scene by viewing the comments. To do this, right-click on the saved scene in the project
tree. Any comments on the scene will be displayed along with the right-click menu:

W [ Saved Scenes and Movies

T, ™ 1, Maps and topography
&, ¥ 2, Displaying drillhole data
playing Iy open

%, ™ 3, Defining the medel bouni ® Comments ab or click to edit
. ® 4, Slicing through a gealagil & Display Changing how objects are displayed is useful in analysing data.
T ®s Using the moving plane Rename B Here, geology intervals are shown with contaminant intervals
‘ - inside.
T ® 6. Using the ruler to measur| 8 Delete... Delete

12 ® 7. Cross section with geological mod

B =) Cross Sections and Contours

In the next tutorial, we will import drillhole data and use it to build a geological model.

© 2018 Seequent Limited



Tutorial 2: Modelling Veins

In this tutorial, we will use drillhole data to build two geological models of a series of veins and
the lithologies in which they occur.

« Forthe first model, we will build individual veins.
« Forthe second model, we will build the veins as part of a vein system.

This tutorial also includes an introduction to setting up project files, importing topographical
and drillhole data and setting up a topography.

Data for this tutorial can be found in the Veins folder.

Setting Up the Project

To start:
1. Launch Leapfrog Geo.
The main window will appear with the Projects tab displayed:

¥ | B8 Projects | [ Scene View

?;g Project Tree —
\J New Project...

[~ Open Project File...

Recent projects | Clear

2. In the Projects tab, click New Project.
The Create Project window will appear:

& Create Project

Mew project name: !_ |

Project file: [C1\UserS\Genlngist\LeapFrng Projects J

= Browse...

ﬁgan:el

3. Enterthe name "Veins tutorial” for the new project and click Browse to select a folder where
the project will be saved.

4. Click OKto create the project.
The project will be created and Leapfrog Geo will display the Scene View tab for that project.

Importing an Aerial Photo

When first created, a project has only a basic set of X-Y-Z coordinates, and the coordinate
system used by the project is determined by the data imported to the project. Itis not necessary
to specify what coordinate system is used; however, it is necessary to ensure that data you
import into the project uses the same coordinate system. Often, the best way to set the
coordinates for the project as a whole is to import a map or aerial photo. Adding georeference
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data to a map will set the location of the map in three-dimensional space and set the
coordinates for the project. For this project, we will import a georeferenced aerial photo.

Data for this tutorial can be found in the Veins folder.
1. Right-click on the GIS Data, Maps and Photos folder and select the Import Map option:

& Veins tutorial - Leapfrog Geo

* | B8 Projects

2 Project Tree a, g Lk

[F=1 Tepographies
E‘ GIS Data, Maps and Photos
¥ [ Drillhole Data
[= Planned Drillholes

Impert Vector Data..,
8 Import 2 Grid..

Import Map...
E‘ Drillhele Correlation poriAap
=) Paint New GIS Line...
omts
Batch Import
[ Polylines mp
¥ [ Structural Modelling Set Clipping Boundary...
g Form Interpolants 5 New Subfolder...
Stereonets T

2. In the window that appears, select the file called orthophoto.tif, then click Open.

The Import Map tab then displays the image:

B8 Projects [ Scene View | i Import Map X

e

b @ Full Acceleration

] |E| / Crop Image (‘B\ 125% | = Q ®\ ﬂa Import @Help

[[] Owverride georeference data from image

37FPS R Z-Scale 1.0

In this window, you can enter georeferencing information foran image, if itis notincluded in
theimage. In this case, the image includes georeference data and nothing needs to be

changed.

3. Click Import to import the photo.
The imported photo will be saved in the project tree in the GIS Data, Maps and Photos folder.
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4. Display the photo by clicking on itand dragging it into the scene:

¥ | BB Projects | G Scene View

PR AN NN N @ &

Plunge +20 @
Azimuth 030

0 500 1000 1500

e
<@ O orthophoto b4 B2 orthoph

Slice mode: | From Scene A

1N 53 Full Acceleration 36FPS  $7Z-Scale 1.0

The photo appearsin both the shape list and the shape properties panel. There are three shape
list controls for the image:

« Clickthe visibility button (®) to show or hide the photo.

« Click the (¥) to remove the image from the scene. This does not remove the image from the
project, as displaying objects and removing them from the scene do not change the data.

o Adjust the photo's opacity using the slider.

These controls appear for most objects when they are in the shape list. The visibility button (=)
and the opacity slider are useful when analysing relationships between objectsin the scene.

Setting the Clipping Boundary

The clipping boundary is the part of the project space in which processing is carried out. When a
projectis created, Leapfrog Geo automatically sets the clipping boundary. As data isadded to
the project, the clipping boundary expands to fit that data. For models with large data sets,
setting the clipping boundary to a fixed size will reduce the amount of time Leapfrog Geo
required for performing calculations.

For this project, we will set the clipping boundary to the area indicated by the imported aerial
photo.

1. Press the D key to view the photo from above.
2. Right-click on the Topographies folder and select Set Clipping Boundary.
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The Set Clipping Boundary window will be displayed, together with controlsin the scene that
will help you to set the clipping boundary:

¥ | BB Projects | G Scene View

Fl-WNEE- (N8BS @ &
MNorth (Y) f

@& Set Clipping Boundary

Clipping Boundary

Minimurn Maximum

X(East): (14706000 |3 [14748000

¥ (Northy: (53556000 |2 [53613000

Enclose Object +

East (X)

Looking down e

0 1250 2500 3750 5000

a> orthophoto b4 — 22 orthoph

3. Use the handlesin the scene to adjust the clipping boundary so it is slightly smaller than the
photo.

4, Click OK.
Data subsequently imported into the project will be clipped to the clipping boundary.

Creating the Topography

In Leapfrog Geo, the topography is used to define the elevation of the ground’s surface. The
topography can be defined using a single digital terrain model (DTM), but often data from
several sources is combined to ensure the data is consistent.

The topography is used as the upper boundary for geological models and to position

GIS data. As a result, changing the topography will cause geological models to be
reprocessed and GIS data to be repositioned. This can be time-consuming, which is why it is
best to define the topography before GIS data is added to the project and before any models
are created.

For this tutorial, a single DTM file will be used to define a topography. It is called topo.asc.
To define the topography from the DTM:

1. Right-click on the Topographies folder and select New Topography > Import Elevation
Grid.

2. Navigate to the folder that contains the topo.asc file and open the file.
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The Import Elevation Grid window will be displayed:

# Import Elevation Grid

Surface resolution:  |25.0 |

Clipping
Clipping will only be applied to grids
where north is vertical on the map.

Clip data to bounding box

Bounding box: | Clipping Boundary [~]

Margin: ID

No Data Handling

(®) Leave a gap
) Replacewith 0.0

Hame: [topo l

I @ﬂalp J ‘ xgaﬂcel Il |7 Import

3. Click Import.
The New Topography window will appear:

& New Topography

Enter a new topography name

[Tnpngﬁphy l

4. Click OKto accept the default name and create the topography.

5. Click on the Clear scene button (¥) to clear any objects from the scene window.
6. Drag the newly-created topography into the scene.

The topography is displayed in three dimensions:

- [ @ & Aexroc-

F - WN BB\ &S @

Marth ()

East ()

Plunge +20 e
Azimuth 030

a 500 1000 1500

Slice mode: [From Scene | hd |

7. Select the imported photo from the GIS data dropdown list:

® 43 Topography # |&Fiatcol..~ l:l = bis 8| No selection
Select - .
Mone
Views v

| Maps and Photos 3 | | . orthephote E |i
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The photo will now appear draped over the topography:

* | BB Projects | @ Scene View

Morth ()

X @ncor][ v

@ £ Topography

&b

GIS data: [ orthophoto ~|
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East (X)

Plunge +20 @
Azimuth 030

o 500 1000 1500

GIS data: orthophoto

In Leapfrog Geo, drillhole data is managed using the Drillhole Data folder in the project tree.

Leapfrog Geo expectsdrillhole data that is stored in a collar table, a survey table and interval
tables. Each project can have only one set of drillhole data, made up of one collar file and one
survey file. Multiple interval tables can be imported, and a screens table can also be imported, if

available.

For this tutorial, there are three data files, which can be found in the Veins > Drillholes folder:

« collar.csv contains the collar definitions.

« survey.csv describes the deviation of each drillhole.

« lithology.csv contains the interval definitions that describes the lithology.

To startimporting drillhole data:

1. Right-click on the Drillhole Data folder and select Import Drillholes.

The Import Drillhole Data window will be displayed:

& Import Drillhole Data

Input Files

|
Collar:

| | ¥ Browse...

Survey:

] — Browse...

Intervals:

= Add...

== Remove

Screens:

;; Help

] = Browse...

(ﬂlmpurt

2. Forthe Collar, click on the Browse button to locate the tutorial file collar.csv.

3. Click on thefile, then click Open.

© 2018 Seequent Limited



22 | Leapfrog Geo Tutorials

When a collar file is added to the Import Drillhole Data window, Leapfrog Geo will look for
interval tables with names such as “lithology” or “geology” in the same location and will add
them to the Interval Tables list. If an interval table file is not automatically added to the list,

click Add and browse for the required file.

In this case, all files have been added to the Input Files list:

[ Import Drillhole Data

Input Files
Collar: [Jsers\Geologist\Desktop\LeapFrog Geo Tutorial DatE\Ve\ns\DriHhoIes\cu\lar.cs\rJ — Browse...
Survey: [serS\Gen\ng\st\Deslctnp\Leapfrng Geo Tutorial DEtﬂ\VEiﬂ5\Dri||hD|ES\SLINE'y.(SVJ — Browse...
Intervals: |...Gealogist\Desktop'Leapfrog Geo Tutorial Data\Veins\Drillholes\litholagy.csv k= Add...
=== Remove
Screens: J ~1 Browse...
;; Help Rgan(sl Firnport

4. Click on Import to start the process of importing data.

First, the collar file is processed. Leapfrog Geo displays the data in the file and summarises how
each column will be imported:

& Import Drillholes

Progress: collar.csv » survey.csv > lithology.csv
File Data Column Summary
Hole ID w | East (X) w | North (Y) v | Elev (Z) v | Max Depth Column Import As Import Mame

1 helad X Y z maxdepth holeid Hale ID
2 |poox7 1472005464 S3STATL687 7971824268 1240633687 X East (X)
3 | PCOHG 1471974295 5357631804  79.26218951  131.7264347 ¥ Nerth (¥)
1 |xooxs 1471853127 S357790.921 7117851999 110.6339749 2 Blev (@)
5 | MFOHS 1472375749 5357434739 1339683683  195.0638123 maxdzpth Max Depth
6 | MFOX2 1472254581 5357593.856  127.1608308 2133913362
7 |MFOHE 1472133412 5357752973 119.6066528  233.2682701
8 | NvOxs 1472012244 535791200 8232085849  205.8401626
9 | KKOH1 1471897.134  5338063.251  B3.B6G02215 2127533356
10 | NTOXG 1472534866 5337555.007 2184323413 2977778623
11 | NTOHG 1472413.698  53ST715.024 1737379586 282814
12 |LTOXD 1472292529 535767441 1514568349 3112084466 e
13 | BGOHT 1472171361 5338033.258 1152233865 3133046808 Character encoding: | Auto (Windows-1252) v
14 | BGOXT 1472056251 5358184419 BIAD2D1991 3040561709 i Fon - (None =
15 | DDOH4 1471947.199 5338327625  73.3422800 2625827921
16 | FLOX2 1472603983 S3ISTETT.OTS 2194324134 3038275788 Select Header Row: |1 -
17 | FLOHT 1472572815 5397836192 2167382121  335.266482 Import All Columns
18 | TTO0X1 1472451646 5357995.309 2182773391 4183100888 S
19 | YUDH3 1472330473 5338154426  129.1085096 3745096984 J i

;_; Help %gance\ .=; Next

Leapfrog Geo expects four columns for the collar data and attempts to match imported data
to these expected formats. For the collar file, Leapfrog Geo expects a drillhole identifier
(Hole ID) and the location of the top of the drillhole, in X, Y and Z coordinates. The Hole ID is
used to associate data in different tables with a single drillhole. Inconsistencies in the way
drillholes are identified isa common source of errors.
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5. Leapfrog Geo has correctly mapped the data in the collar file to the expected format. Click
Next to proceed to the next file.

The survey file data is displayed:

& Import Wells

Progress: collar.csv > survey.csv > litholagy.csv
File Data Column Summary
Hole D w | Depth w | Dip w | Azimuth v Celumn Import As Import Name

1 heleid depth dip azimuth holeid Hole ID
2 | PCOX7 0.0 90.0 0.0 depth Depth
3 MFOX2 00 %0.0 00 dip Dip
4 | Mvoxe 00 300 00 azimuth Azimuth
5 NTOXE 0.0 90.0 0.0
6 | NTOHG6 0.0 %0.0 0.0
7 |LTOX0 0.0 90.0 0.0
8 |BGOH7 0.0 %0.0 0.0
9 | BGOXT 0.0 90.0 0.0
10 | DDOH4 0.0 $0.0 0.0 Name:
11 | FLOXZ 0.0 90.0 0.0
12 | FLOHT Do 30.0 Do Character encoding: | Auto (Windows-1252) -
13 | TTOX1 0.0 950.0 0.0 Unique Row 1D: lNone -
14 | YUOH3 0.0 60.0 0.0 [ Negotauc Dip Points Dawn
15 | YUOXS 0.0 90.0 0.0
16 | UZOH9 00 %0.0 00 Select Header Bow: 1 :
17 | FTOX4 0.0 90.0 0.0 Import All Columns
18 |FTOH2 0.0 90.0 0.0 D il
19 | MROX2 0.0 90.0 0.0 -| sV characters

I Help 8 concel 5 Previous & Next

Leapfrog Geo expects four columns for the survey data, a Hole ID and deviation depth,
azimuth and dip.

6. Leapfrog Geo has correctly mapped the data in the survey file to the expected format. Click
Next to proceed to the next file.

The interval table is displayed. The “lithology” column has been correctly mapped as lithology
data, but the "veins” column has not been mapped.
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7. In the Column Summary, click on the dropdown list for the “veins” column and select

“Lithology™:
Progress: collar.csv > survey.csv > lithology.csv
File Data
Hole ID w |From To w | lithology | Not Importedw
1 holeid from to lithology “veins” Lithology
2 | AEDX1 0 28341 Schist A ‘veins® Category
3 | AEDX1 98.341 113.152 Vein C veins® Text
4 | AEDX1 13132 120525 Schist A veins” Numeric
5 | AEOXT 120525 135.206 Vein A veins® Lime Stamp
6 | AEDX1 135.206 200431 Schist A veins” Date
7 | aE0x1 200.431 223737 Schist B veins URL
8 | AEDX1 223737 232761 Vein B Not Imported
9 | AEDX1 232761 270.098 Schist B HoleID
10 | AEOXI 270,098 27M.217 Vein D From
11 | AEDXT 271.217 346287648 Schist B To
12 | AvOH2 0 135,371 Schist A Custorn Name...
13 | AYOH2 135371 3606082176 Schist B ;
14 | AYOX6 0 11.14 Cover Cover
15 | AYOXE 11,14 172338 Schist A Schist A
16 | AYOXE 172338 2803131091 Schist B Schist B
17 | BGOHT 0 11.387 Cover Cover
18 | BGOHT 11387 150.004 Schist A Schist A
19 | BGOHT 150,084 3123046808 SchistB Schist B
Hidelp

Column Summary

Celumn
holeid
from

to
lithology

veins

Mame:

Character encoding:

Unique Row ID:

Select Header Row:

P Date and Time Formats

B CSV characters

&Qance\ ; Previous

Import As Import Mame
Hole ID

From

To

Lithology lithology
Mot Imported

[\ithology

Auto (Windows-1252) v

[Nnne v

[1 z

Import All Columns

2
%]
=
Z
JL
Im
3,
Z
it

The Column Summary is updated to indicate that the "veins” column will be imported as
lithology data:

Column Summary

Column Import As Import Name
holeid Hole ID

from From

to To

lithology Lithology lithology
veins Lithology ¥ veins

8. Click on Finish to complete the process.
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The data tables will be added to the project tree as part of a new Drillholes object:

& Veins tutorial - Leapfrog Geo

T Project Tree 3,
¥ [ Topographies
P & Topography
[F) Draped GIS Objects
W [ GIS Dats, Maps and Photos
g‘ orthophoto
¥ [ Drillhole Data
¥ |I] Drillholes
B = collar
T survey
& Drillhole traces
% Drillhole Graphs
P " lithology
E‘ Compaosites
[ Planned Drillholes
E‘ Drillhele Correlation
E‘ Points
E‘ Polylines

Leapfrog Geo automatically identifies and flags common drillhole data errors when drillhole
data tables are imported. There are three ways Leapfrog Geo marks tables that contain conflicts
Or errors:

« Tables containing errors are marked with a red X (¥)). These errors must be fixed before the
affected drillholes can be used for processing.

« Numeric data columns with non-numeric values are marked with a red X (), which means
that the rules that are used to handle non-numeric and negative values need to be reviewed.
If a drillhole has intervals that contain non-numeric and negative values, the drillhole cannot
be used for further processing until the rules are verified.

« Tables containing warnings are marked with a yellow exclamation mark (7). Affected
drillholes can be used for further processing, but the information in the warning can indicate
that the data requires further attention. For example, if a warning indicates there is data
missing for a drillhole defined in the collar table, it may be that a drillhole has been
duplicated or that not all required data files have been loaded. Warnings are listed along
with table errorsin the Database Errors window.

Until errors are corrected, the rows that contain those errors are excluded for all processing that
usesthe table, including viewing in the scene. For example, if the ID for a collar position
contains an invalid coordinate, that collar will not be displayed in the scene as its location is not
known. Likewise, any processing will ignore data associated with this drillhole.

Itis worth correcting errors as soon as possible, as correcting them later can result in significant
recomputation time.

For this tutorial, there is only a warning for the survey table that we will not correct.

Analysing the Data

Once Leapfrog Geo hasimported the data, we can view it and analyse it to make decisions on
how to build the geological model.

1. Click on the Clear scene button (¥) to clear any objects from the scene window.
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2. Display the data by dragging the Drillholes object into the scene:

¥ | B8 Projects ‘ P Scene View |

%gprojactlree \ & Look v w \ ﬂ H

¥ [ Topographies
P £ Topography
[ Draped GIS Objects
¥ [ GIS Data, Maps and Photos
orthophoto
W [ Drillhole Data

¥ ||| Drillholes
B 7 collar \
o sUrvey
R Drillhole traces By
}k. Drillhele Graphs
B =7 lithology ’ﬁ I

E‘ Composites
[= Planned Drillholes
E‘ Drillhole Correlation
E‘ Points
E‘ Polylines

3. Zoomin to get a better view of the data.

Both the lithology table and the collar table are displayed and an entry for each appearsin the
shape list:

- EIIET‘,jemrjs:enevueﬂ
Sl M\ S [GN & 7 @ @

=S QR EG

North (¥)
+5359000
n
=]
=]
S
S -a
c
£ &
= I
m o
(9]
S ecan |

+1473200

o
g
i 375
"
i f—z00 7
< ] lithol mlithology-” Edit Colours i1 [l i\ il =] 7 lithology
® 8 it ol I ———( : Fromsems
= &l x ‘F\at col A Slice mode: From Scene lix |

The colours used to display the drillhole data will be different from those shown in these
images as colours are assigned randomly when data is imported.

Changing how the drillholes are displayed can help in analysing the data and making modelling
decisions.
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Drillholes can be displayed as lines or as cylinders, which is controlled using the Make lines

solid button (¥) button.
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4. Click the Make lines solid button (¥) to display the drillholes as cylinders:

@ ] lithology b4 @nthumgyvu Edit Colours | ——— | 1 [N Til lithology
] collar ¥ | &Pt col — Make lines solid mode: From Scene |
Query filter:

Line width:

Format Display Text |

The width of the cylinders can be changed in the shape properties panel:

5. If the drillhole cylinders are too large or too small, adjust the Line radius to a suitable value.

@ "~ lithology 38 [ lithology~ || Edit Colours | ==——{ | L‘ A F
O cola 3 [@Forco..- NN —— )\ A

6. Click the Show legend button (=) for the table:

v | BB Projects ﬂScEneViaw‘

| lithology
Seemote [romses )
Query filter: | No Filter v |

Line radius: 20.00 =]

| Format Display Text

F - WN BB (LN B

uZo

poo

358000

RMO

[Bits) P i

@ ] lithology
@ "] collar

o
=

3 (8 ithology~|[ Edit Colowrs | ———( | ip s ° F]
8 (@ratcol- | [N —— ) A

@

lithology B3
Cover

Schist A

) . Schist B
' .Vein A

Vein B

Plunge +20 e
Azimuth 030

0 100 S 200 300
—_———

=+

41473000

7. In the shape list, click the (¥) button to remove the collar table from the scene.

8. To get a betteridea of how the layers are organised, click the Edit Colours button for the

lithology table:
@ ] lithol 38 [/, ithology - |[ Edit Colours | et 1l A8 El| | ™1 tithology
Sicemads  [Fomscene |+
Query filter: | Mo Filter v |
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9. Click the visibility button (=) for each of the vein lithologies to hide them in the scene:

¥ | B2 Projects | [ Scene View
&] Lock v w N ﬂ I:E i

& Legend for lithology

ﬁw’ﬁ*

lithology 3 |

Cover |

. ﬂ/ Schist A |
- .Sch\st B

“

Plunge +20
Azimuth 030

Q 1003 200 30

ﬁ
o
o
c

Code
@ [Cover
@ [5chist A
“® [5chist B
Vein A
Vein B
Wein C
Vein D

EECEROO

‘%Qancel Ol

o
~

o

5358000

y+t 73

o
2
A <

< ] lithology 3£ [ lithology - |[ Edit Colours | LA =] | ™ sthology

Note that the legend is updated to reflect only the visible lithologies.

To select multiple lithologies, use the Shift or Ctrl keys while clicking. You can then change the
visibility of all selected lithologies by clicking one of the visibility (®) buttons.

Hiding lithologies in this way only changes how the data is displayed in the scene. Another
way of limiting the data displayed is to use a query filter, which can later be used in selecting
a subset of data for further processing.

We can see that the lithology layers, from oldest to youngest, are:
o Schist B (purple)
« Schist A (yellow)

o Cover(green)

When building a geological model, it is best to define the contact surfaces by starting with the
oldest and working up. For this project, Schist Band Schist A are deposits and are the oldest
lithologies. They are then cross-cut by the vein lithologies, and the deposits and veins are
eroded by Cover. Therefore, the best way to build this model is to:

o Model the deposits, Schist B and Schist A.
« Model the veins.
« Model the erosion.

10. Click the Cancel to close the Legend window.

Creating the First Geological Model

To create the first geological model:
1. Right-click on the Geological Models folder and select New Geological Model.
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2. In the window that appears, change the following settings:
» Setthe Surface resolution to 50.

o Fromthe Enclose Object dropdown, select the lithology table.

¥ | B8 Projects | [P Scene View l—J
F - W FHE- LM\ RS = 2

& New Geological Model x lithology B3
Cover

Schist A

General

Base lithology column: [If-g‘llithulugy A J—— .SchistB
. Vein A
= Vein B
Surface resolution: |SD.D =] Adaptive * Vein €
Model Extents . . [lveino
Minimurm Maxirmum é
X(Easth  [1471800.0 2 (14733000 5
¥ (North): ‘.SBSTBDD.D % 53592000 —
. x
Z(Elev: |-3000 2| [2600 %
L i
Enclose Object v
Name: :GM |

Plunge +20 @
Azimuth 030
<Jox

e
Wy Help & cancel 0 250 500 750 1000

< ] lithology 4 lithology = || Edit Colours L fix :—El | lithology

All settings can be changed after the model is created, except for the Base lithology
column. For the Surface resolution, Leapfrog Geo sets a value based on the data available,
but you can set a higher (coarser) value when you first create the model in order to reduce
processing time. Lower resolution values provide more detail, but surfaces will take longer to
process.

3. Click OK to create the geological model.

The new geological model will be created in the Geological Models folder:

v E‘ Geological Models
v (@ am
P @ Boundary
&3 Fault System
[ g :—E‘ Lithologies
@ Surface Chronclogy
P [ Qutput Volumes

« The Boundary object defines the limits of the geological model. When the model is first
created, thisisthe rectangular model extents. If a topography has been defined, itis
automatically used as the upper boundary.

« The Fault System object defines faults and their interactionsin the model.

« The Lithologies object describes all the lithological units to be modelled in the geological
model and the colours that are used to display them on the screen. It is generated
automatically from all the lithologies identified in drillhole data selected when the model is
created. If no column was selected, you will need to define the lithologies manually before
you start modelling the lithology layers.

« The Surface Chronology object describes the contact surfacesin the model, organised in
chronological order, from youngest to oldest. These surfaces and their chronology
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determine how the volume inside the model extents is divided into lithological units. When
the model is first created, the Surface Chronology is empty, but it will eventually hold all
contact surfaces and inputs to them.

o The Output Volumes folder contains all the volumes generated in building the geological
model in chronological order, from youngest to oldest. When the model is first created, the

Surface Chronology is empty and so there is only a single output volume that fills the
model’s extents, called “Unknown”.

4. Double-click on the Lithologies object.

The Geological Model window opens with the Lithologies tab displayed. The lithologies for the
new geological model include those from the drillhole data and the lithology “Unknown”:

& Geological Model - GM

General Boundary = Fault System Lithologies | Chronology

Code

[a]
-3
o
c

Unknown
Cover
Schist A
Schist B
Vein A
VeinB
VeinC
VeinD

BO00

]
(]
]

o Add

5. Click Cancel to dismiss the Lithologies window.

6. Clear the scene.

7. Display the geological model by right-clicking on it and selecting View Output Volumes.

¥ | B5 Projects [ Scene View |---W--- =x Ra Q

F - WNB B R\ &S @ &

Morth ()

East (X)

Plunge +20 @
Azimuth 030

0 250 500 750 1000

@ 7 GM 388 [(fcm -] Edit Colours | ——— Y = {7 cm
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At this point, the model is a single volume of lithology “Unknown”. In order to divide this
“Unknown” volume into volumes that represent known lithologies, we need to define the
model's internal structure. This involves:

« Generating contact surfaces that correspond to the boundaries between lithological units
« Refining the contact surfaces

« Arranging them in chronological order

« Using the surfaces and the chronological order to divide the geological model into units.

There are different types of contact surfaces that interact with other surfaces and volumes in
different ways:

« Deposit contact surfaces do not cut older volumes. A volume defined by a deposit contact
surface will, therefore, appear conformably on top of older volumes.

« Erosion contact surfaces cut other contact surfaces on the older side of the erosion contact
surface.

« Intrusion contact surfaces remove existing lithologies and replace them with the intrusive
lithology on the younger side of the contact surface. Often, the older side of an intrusion
contact surfaceis labelled "Unknown” as typically intrusions displace multiple older
lithologies.

« Vein contact surfaces remove existing lithologies and replace them with the vein lithology
within the boundaries defined by hangingwall and footwall surfaces and pointsand a
reference surface.

It is not always necessary to model geological formations according to their corresponding
contact surface type. For example, it might make sense to model basement granite as a deposit
rather than as an intrusion when it forms the lowest layer in a geological model: if there are no
older layers for an intrusion-type contact surface to remove and it isapparent from the drillhole
data that the lithology simply fills the lowermost parts of the model, then it makes sense to
model it as a deposit.

See the topic in the Leapfrog Geo online help for more information on the
different types of contact surface and how they interact.

For the geological model in this tutorial, however, we can model each lithology according to
the corresponding contact surface type.

Modelling the Deposit Contact Surfaces
In , we saw that the oldest lithologies in the drillhole data are two deposits:

e SchistB
e Schist A

The first contact surface we will model is the oldest (lowest), Schist B, and we will model it as a
deposit.
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1. Right-click on the Surface Chronology object and select New Deposit > From Base

Lithology:

v E Geological Models
v (7 Gm
P i@ Boundary
&3 Fault System
P =] Lithologies
'\'? Surface Chronology
B [ Output Volumes
E Mumeric Models
E Combined Models
[ Block Models
E Saved Scenes and Movies j“‘ MNew Vein

Open

ﬁ_ﬁ New Deposit
:ﬁ: Mew Erosion

’ Mew [ntrusion

North (¥)

‘ & No Comments |

#% From Base Lithology... I}
v“ﬁ From Other Contacts...
g From Polyline...

From GIS Vector Data...

[F=) Cross Sections and Contour| % New Structurs] Surface & From Structural Data...
[ Colour Gradients 4 New Vein System #. From Points...
™) Motes 3 MNew Stratigraphy X From Offset Surface...
View All &2 From Surface...
f Prioritise
B?rﬂ Properties...

2. In the window that appears, select "Schist B from the Select primary lithology dropdown

list:

& New Contact Paints

Lithelogy | Compoesiting

Query filter:
Select primary lithology

Contact in Column "lithology’ on Table "lithology"

Inherit from GM

[l:l Cover

I:l Cover
[ schist A
[ Schist B N
[ veina
[ veink
B vein C
B VeinD

Treat unspecified intervals as
® Ignored ) Primary

Reference Plane

Horizontal plane

(B Vein C (@)
B vein 0 (D)

) Contacting

MName: | Cover contacts

‘;; Help

% Cancel Qﬂg»{

We saw in

that Schist B contacts Schist A, so we want to build a surface that

represents the contacts between Schist B and Schist A. Therefore, we will keep Schist Ain the
Contacting/Avoiding lithologies list. The veins, however, are younger lithologies than Schist B
and Schist A, so we want to ignore them.
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3. Drag each of the vein lithologies to the Ignored lithologies list:
& New Contact Points *

Litholegy | Compositing

Contact in Column 'lithology’ on Table “lithology*
Query filter: Inherit from GM
Select primary lithology

[ schist & v

® Use contacts above O Use contacts below

Contacting/Avoided lithologies: Ignored lithologies:

Schist A (80) Cover (0)

] ]

] vein & (8)

] veinB (9) Bvercor |
I vein C (16)

I veinD (3)

Treat unspecified intervals as
® Ignored O Primary ) Contacting

Reference Plane

Horizontal plane

Mame: |Schist B contacts l

4. Click OK.
The new contact surface will appear in the project tree under the Surface Chronology.
5. Expand the contact surface to view the objects used to create it:

¥ [ Geological Models
v {7 6m
| =] Boundary
&5 Fault System
> :—E‘ Lithologies
¥ (# surface Chronology
W (# Schist B - Schist A contacts [inactive]
W 4% Schist B - Schist A contacts
W A Schist B - Schist A contacts
(B lithology
[ E‘ Output Volumes

Note that the contact surface is marked as inactive. When you create a contact surface, it
appearsin the project tree under the Surface Chronology object, but it is not enabled and,
therefore, does not affect the geological model volumes. This means you can work on the
surface without having to reprocess the model whenever you make a change to the surface.
In Leapfrog Geo, you can easily define, enable and remove contact surfaces from a model,
and you can experiment with modelling lithologies using different techniques in order to
arrive at a geologically reasonable model.

6. Clear the scene.
7. Add the new contact surface () to the scene, together with the points (*) and segments ()
used to createiit.

8. Display the legend (&) for the segments.
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The segments (~) show how the lithologies in the drillhole data have been handled in order to
create the contact surface:

¥ | B2 Projects | [P Scene View bk |

FARTES AN RN EN @

SchistB- H
Schist A co...

.Avoidad
. Ignored
. Primary

o
3
= =
o E
8 5
52 !
- 8 g g 8 2 g 2 g g g
N m m ﬂ g ~ @ = [=] — ~ b
= [ - I ~ I 2 = = b "Plunge +02 2
& s =+ o+ = + - = - g . 4
3 = 3 = - 3 - 3 - 3 “hzimuth 350 o
& b + + + + + T T ¥ oo t on oo Ul
® 4 GM: Schist B - Schist A contacts % (& Flat col...- | ) —— [~ Schist B - Schist A contacts
<@ {# GM: Schist B - Schist A contact 3¢ [@ Litholo... - . —— b i

2 ke oo b Slice mode: | From Scene v
<® [\ Schist B - Schist A contacts 32 [ Schist... »|[ Edit Colours | A A ]

Line width: 2.00 =

The underside of the contact surface is Schist B (purple) and the top side is Schist A (yellow).
9. Double-click on the Surface Chronology.

The Geological Model window will be opened with the Chronology tab displayed:

10. Tick the box to enable the contact surface:

& Geological Model - GM

General Boundary Fault System  Lithologies | Chrenology

| Contact surface chronclogy

Contact surface
{# Schist B - Schist A contacts

o

Younger

Older
3

Background lithology: I:lUnlcnown x|

11. Click OK.

12. Once the changes have been processed, drag the Output Volumes folder into the scene.

© 2018 Seequent Limited



Modelling the Veins | 35

The Schist B output volume (#) has filled the space indicated as the primary lithology:

gFLookvw\@EH,MV\\ﬂég L
SchistB- H
Schist A co...
.A\tc\ded
.Ignored
.Pr\marv

Morth ()

East (X)

Plunge +24 @
Azimuth 040

Q 250 500 750

<@ ¥ GM: Schist B - Schist A contacts 3 (@ Fat col..- | [N ————( ) B SchistB

® g [db Litholo...- | [N ———(ou] i |
B G schist A R [&Linle e I Slce mode: )

< B GM: Schist B 8 [&vitholo.. - [ —— D] Fill Slicer

@ [ GM: Schist B - Schist A contacts ¥ [@ltholo. -] | —— DB &

® [\ Schist B - Schist A contacts ® Edit Colours | =—— | A2 H

The lithology on the younger side of the contact surface has been used to fill the remainder of
the model space.

When you right-click on the geological model in the project tree, there are three ways to view it:

« View Object adds the geological model to the shape list as a single object. You can also
display the model in this way by dragging it into the scene.

o View Output Volumes adds the volumes in the Output Volumes folder to the scene. You
can also display the model in this way by dragging the Output Volumes folder into the
scene.

« View Surface Chronology adds the model's surfaces to the scene.

Modelling the Veins

Veins can be modelled as individual contact surfaces or as a vein system. When the drillhole
data hasthe veins sorted into individual lithologies, it is best to model veins one-by-one.

1. Clear the scene.

2. Right-click on the Surface Chronology object and select New Vein > From Base Lithology.
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3. Inthe window that appears, select “Vein A"

& New Vein X

Vein in column ‘lithology” on table 'lithology®

Query filter: Inherit from GM

Vein lithology: I:l Cover v

Include poi l:l Cover
Schist A

Mame: [Cuver - Schist B
- [lveina Iy
&y Help [Jveine
\u’eln C =i
-Veln D

4. Click OK.
The new vein surface will appear in the project tree under the Surface Chronology.

5. Expand the vein to view the objects used to create it:

¥ [ Geological Models
¥ [# om
B @ Boundary
&5 Fault System
> :—5‘ Lithologies
¥ (#* Surface Chronology
¥ % Vein A [inactive]
P[> Vein A Hangingwall
B [» Vein A Footwall
B A vein A
B A% Vein A Pinch Outs [inact
B 77 Vein A Reference Surface
¢' Wein A Boundary [empty]
B (3 Schist B - Schist A contacts
P [ Output Volumes

The vein is made up of:

« Hangingwall and footwall surfaces (#), which, when expanded, show the hangingwall and
footwall data objects used to create the surfaces.

« Vein segments and pinch out segments (+) extracted from drillhole data. These are only
included when a vein is created from lithology contacts and are disabled when the vein is
first created.

« Areference surface () calculated as the best fit surface using the hangingwall and footwall
surfaces.

« Aboundary object (%), which is empty when the vein is first created.
6. Drag the vein into the scene and make it partly transparent.

a
waty

7. Expand the hangingwall and footwall surfaces surfaces (#) and add their points objects (%)
to the scene.
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The scene will appear similar to this:

¥ | BB Projects | [ Scene View

é] Look'mkﬂmvgrk\ng

North (¥)

2
P
s
e
re o
L] L
Elev (Z) - L
L]

+200

<@ &, Vein A: Vein A Footwall

38 [TAHw/ Fw- || Edit Colours |

<@ &, \ein A: Vein A Hangingwall

@ B GM: Vein A

3¢ (ST, rve] e Cotows |
% (@ T, -] — ba
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East ()

Plunge +20 @
Azimuth 030

250 375 500

125

e, Vein A Footwall

Slice mode: From Scene -

Query filter: Mo Filter -

We can see that the vein extends well beyond the Vein A hangingwall and footwall points.

8. Expand the geological model’'s Boundary object (not the vein boundary) and add the GM

Extents object to the scene.

9. Press the D key to view the scene from above.

10. Zoom out to view the GM Extents in relation to the vein:

¥ | BB Projects | [ Scene View

é] Look'mkﬂmvgrk\ng

@ ., Vein A: Vein A Footwall

@ &, VVein A: Vein A Hangingwall

North (Y)
+5359000
+5358500 /
J‘
-¢-5358nnull“"I
) o o
] ] ] .
+5357500 5 [ p
2 3 3 @
+ t + i
Etevaz)

3¢ [TAHw 7 P~ || Edit Colours
3 | TAHW/ FW~|| Edit Colours

Looking down e

500 1000 1500

< (7] GM Extents

@ (% GM: Vein A

% [&Litholo...-] Py

(£f) GM Extents

Slice mode: | From Scene -

The problem with the shape of the vein is that it extends to the model boundary, in spite of the
hangingwall and footwall points being restricted to the centre of the model.

Vein walls can be set to pinch out where drillhole data indicates they do not occur. This s
achieved by creating ‘outside’ intervals on drillholes that do not have an interior vein segment.
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These intervals are then flipped with respect to interior vein intervals, which, in effect, means the
footwall and hangingwall orientation has the opposite sense to the nearest interior intervals.
This forces the hangingwall and footwall surfaces to cross, thereby pinching out. These
pinchout points can be viewed in the scene and edited, if necessary.

11. Double-click on the vein (%) in the project tree.

12. In the Edit Vein window, click the Surfacing tab, then tick the box to enable the Pinch out
option:

@& Edit Vein A

Lithologies | Surfacing | Inputs

Boundary filter: | Drilling enly v
Snap to data: Inherit from GM (Off) v

Inherit resolution from GM

[] Maximurm thickness:

Minimum thickness: |0 n

I ["] Pinch out I

Name: |Vein A I

i | [ Rows | [P

13. Click OK.
When the changes have been processed, the revised vein will appear in the scene:

i R
R AN LRI @ o

~ | BB Projects | G Scene View

Plunge +44
Azimuth 334

472800

= 0 250 500 750
8
3 8 =
@ s, Vein A: Vein A Footwall 3 TIHW/FW- || Edit Colours f:i Vein A
@ s, Vein A: Vein A Hangingwall 3 | TAIHW/ FW- || Edit Colours Slice mode: From Scene v
@ () GM Extents 3 (@ Flat col..- | I Eill Sli
1 Icer
@ (5 GM: Vein A 8 & Litholo...~ || | Py e

The vein now pinches out and no longer occurs where there is no Vein A in the drillhole data.
14. Create veins B, C and D in the same manner, enabling pinch outs.
15. Clear the scene, then add the veinsto it.
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~ | BB Projects | [ Scene View |

Modelling the Veins | 39

FARTRS AN N RAINENE P
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Elev (Z)

+1472300

< (¥ GM: Vein A

+1472600

+1472700

+1472800

* &L.tho|g..,v||§| —

@ (% GM: Vein B
@ % GM: Vein C
@ (% GM: Vein D

32 |& Litholo... ~
% (@ Cirore.. | I
3¢ [& Litholo...- | [ ———

0

4§ VeinA
Slice mode:

Fill Slicer

Plunge +20 e
Azimuth 030

From Scene | v |

+1473200
East (X}

200 300

At this point, we have changed the vein settings so the veins are a more realistic shape. However,
they are not yet enabled in the geological model.

16. Double-click on the Surface Chronology.

17. Enable each vein and arrange them so they appear in the following order:

18. Click OK.

19. Clear the scene.

& Geological Model - GM

Contact surface chronology

Contact surface

# Schist B - Schist A contacts

General Boundary Fault System E.i‘!hulugis| Chronology |

Background lithology: I:lUnlcnuwn -
xﬂe‘p | xgancel | | @QK |

20. Once the model has been processed, add the Output Volumes folder to the scene.
21. While holding down the Ctrl key, click on Schist A and Schist B in the shape list.
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22. Drag the opacity slider to make the deposits partly transparent:

+ (] @ scneiew
Flo-WNFE- NS @

<® {§ GM: Schist A ® (& Litholo..- - o o

| | 52 shapes
<@ {8 GM: Schist B ¥ |&Llitholo.. - I:l o o i o
® & GM: Vein A X I:l — Fill Slicer
® & Grvend 2 [ oo - I ——0) b
@ @ o venc X (@i | I —— ) b
® B Gt VeinD % (& volo..- | I —— ) b =)

To see how the veins cut the deposits:
23. Remove all the volumes except Schist B from the scene.
24. Make Schist B opaque.

The scene should appear similar to this:

r @ s
AR AY A AN 4 @ &
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Modelling the Erosion Contact Surface

The final step in building the model is to create the last contact surface, Cover, which will be
modelled as an erosion contact surface.

1. Right-click on the Surface Chronology object and select New Erosion > From Base
Lithology.

2. Inthe window that appears:

« Select "Cover” from the Select primary lithology dropdown list.

» Clickthe Use contacts below button.
As Coveris the uppermost lithology in the model, we need to select contacting lithologies from
the contacts below. Both Schist Aand Vein A appear in the Contacting/Avoided lithologies list:

# New Contact Points X

Lithelogy | Compesiting

Contact in Column 'lithology’ on Table “lithology*
Query filter: Inherit from GM

Select primary lithology

":l[over -
() Use contacts above @) |Use contacts below
Contacting/Avoided lithologies: Ignored lithologies:
[ Schist & (47 B schist & (0)
[ veinam [ veinB @

B vein C (0)

[ vein D (0)

Treat unspecified intervals as
® Ignored ) Primary ' Contacting

Reference Plane

Horizontal plane

Mame: | Cover contacts l

When we created the deposit contact surface, we ignored the vein lithologies because they
were younger than the deposits we were modelling. Here, however, Vein Ais older than Cover
and so we will keep it in the Contacting/Avoided lithologies list.

The other lithologies, however, appear in the Ignored lithologies list because there are no
contacts between those lithologies and Cover. This might not always be the case. For example,
when drillhole data isappended, there could be contacts between Cover and these other
lithologies. Because Cover isyounger than all other lithologies, we need to move the lithologies
in the Ignored lithologies list into the Contacting/Avoided lithologies list.

3. Drag each lithology from the Ignored lithologies list into the Contacting/Avoided
lithologies list.

4. Click OK.

© 2018 Seequent Limited



42 | Leapfrog Geo Tutorials

Once a contact surface has been created, itisa good idea to view it in the scene to ensureitis as
expected.

5. Clear the scene.

6. Add the new contact surface to the scene.
7. Add the lithology table to the scene.

The scene should appear similar to this:

FARTES ANE N RN @ @
lithology &1

Cover

T Schist A

.SchlstB

.Uein A

Wein B

.\J'eln c
.Vein D

5358600

4
45358400
5358200

Plunge +20 e
Azimuth 030

0 125 250 375 500

a

mhtho\ogyquditCOIOUr; LﬁTI PO O ™ lithology
@ G: Cover contacts 2 (@ oo W] ——C0 05 2 || oot [romsee 7]

i

8. Double-click on the Surface Chronology.

Because we've defined the contact surfaces from oldest to youngest, the Cover contact surface
appearsin the Surface Chronology as the youngest lithology, so there is no need to change the
chronology.

9. Enable the erosion contact surface.
10. Click OK.
11. Clear the scene.

12. Once the changes have been processed, add the Output Volumes folder to the scene.
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The erosion contact surface has cut away the deposits and veins:

¥ | BB Projects | [ Scene View |

| 8 Alex Rock + |

Fle-WMNSE-[J\ &S
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X (@ oo, ) b
X (@ i, I —— ) b

13. Pressthe D key to view the scene from above.
14. Click the Show slicer button (™).
15. Click on the slicer in the shape list.

16. In the shape properties panel, click on the Set to button and select Elevation (Z) Axis:
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With the slicer tool selected, hold the Ctrl key and the right mouse button to change the
position of the slicer in the scene:

¥ | BB Projects E"chenewew‘ ]
& Lok~ @@ E'IE{\@&P @ d

Looking down e

= 0 250 500 750
Plan section —6.90 =

 slicer £ %, Slicer
@ @ GM: Cover & Litholo... - e T
@ {8 GM: Schist A o [Bilehob - ] =]/ ezl
® @ GM: Schist B ¥ [& Utholo..- | NN ——— Step size:
@ & GM: Vein A 3¢ (@ Litholo... - | ) ———( ) | Dip: ‘ [z w =
@ {8 GM: Vein B 3¢ (& Litholo... - | [N - e M [z [-eommsionms|s
@ & GM: Vein C ¢ & Litholo... ~ l:l c =
@ @ GM: Vein D % [& Utholo.. - | ——( -

- Full Acceleration 39FPS @ Z-Scale 1.0

Using a Vein System

There are two ways of modelling veins in Leapfrog Geo:

o Model individual veins. Thisis the approach we used for the first geological model. The veins
interact with one another and with other lithologies as defined by the Surface Chronology.

» Model a vein system. The vein system represents a single lithology within the geological
model. How the veins interact with one another is determined by settings in the vein system,
and how the vein system as a whole interacts with other lithologies is determined by the
Surface Chronology.

The lithology table in the drillhole data imported in Importing the Drillhole Data has two
columns:

o The lithology” column contains the two deposits (Schist A and Schist B), the erosion and four
vein lithologies.

« The "veins’ column contains the two deposits, the erosion and a single “Veins” lithology that
represents all the veins.

In order to model a vein system, we will create a new geological model using this “veins” column
and model the veins as part of the vein system using the data in the “lithology” column.
To start:

1. Clear the scene.
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2. Right-click on the Geological Models folder and select New Geological Model.

3. Inthe window that appears, change the following settings:
« Select the “veins” column for the Base lithology column.
» Setthe Surface resolution to 50.
« Fromthe Enclose Object dropdown, select the lithology table.

Name the model “Vein system GM".

& MNew Geological Model

General

Base lithology column: | veins b

Surface resolution: 50.0 % O Adaptive

Model Extents

Minimurm Maximum

X(Easty 14712000 2| [14733000

¥ (North): (53573000 2| [s3502000

Z(Eev: [-3000 2| [2600

Enclose Object +

Mame: |Vein system GM|

gﬂe\p %Ean(sl @QK

4. Click OKto create the geological model.

Creating the Vein System

For this model, we won't model the deposit and erosion contact surfaces, but will only model
the vein system.

1. Right-click on the Surface Chronology and select New Vein System.

2. In the window that appears, select "Veins” for the Vein lithology:

& New Vein System

Select lithology

Vein lithology: l:lUnknﬂwn -
I:l Unknown

Cover

MName: | Unknown \u'e|||:| Schist A
- Schist B

l:lVein; I,\\)
;_;_ﬂelp %Qaﬂcel (,'J_‘JQK

Outside lithology:

Because veins usually contact multiple lithologies, leave the Outside lithology set to
“Unknown”.

3. Click OK.
The new vein system will appear under the Surface Chronology. It isempty and inactive.

Creating the Veins

Next, we will define each vein using the lithology data from the “lithology” column.
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1. Right-click on the vein system and select New Vein > From Other Contacts.

2. In the window that appears, select the “lithology” column.

3. Click OK.

4. In the New Vein window, select “Vein A", then click OK.

The new vein will be added to the project tree as part of the vein system.

5. Expand the vein system and add the new vein to the scene.

: @5t

& Alex Rock +

F - WNEE- (NS

Morth (¥)

125

@

Plunge +20

Azimuth 030

250

375

East (X)

©

500

4} Vein A

We need to enable pinch-outs for the vein in order to achieve a realistic shape.

6. Double-click on the vein () in the project tree.

7. Click on the Surfacing tab and enable the Pinch out option:

8. Click OK.

@ Edit Vein A

Interactions  Surfacing | Inputs
Boundary filter: | All data v |
Snap to data: Inherit from GM (Off) v |

Inherit resolution from GM

[] Magimum thickness: | ©
Minimum thickness: |0 Ai

I [] Pinch out I

Hame: [VEin A l

| @ﬂe\p | I xgance\ ‘I @QK l

When the changes have been processed, the revised vein will appear in the scene.

9. Create veins B, C and D in the same manner, enabling pinch outs.

10. Clear the scene, then add the vein system to it.
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The vein system appears in the shape list, but there is nothing in the scene as we need to enable
the veins in the vein system and set their interactions.

Setting the Vein Interactions

We can determine how the veins interact by displaying them in the scene.
1. Clearthe scene, then add each of the veins to it.
2. Press the D key to view the scene from above.

3. Click on the second vein down, as shown:
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Thisis Vein A, which will we consider the central vein. In order to determine the interactions
between Vein A and the other veins, we need to know which side of Vein Ais the hangingwall
and which side is the footwall. We can do this by adding Vein A's hangingwall and footwall
points to the scene.

4. Expand Vein A in the project tree to view the points that make up the hangingwall and
footwall surfaces:

¥ [ Vein system GM
[ = Boundary
&5 Fault System
> :—5‘ Lithologies
v ‘\? Surface Chronology
¥ % Veins Vein System [inactive][smpty]
¥ (5 VeinA [inzclive]
¥ N VeinA
¥ [» Vein A Hangingwall
P &%, Vein A Hangingwall
P> - Vein A Pinch Quts Hangingwall
¥ [ Vein A Footwall
P %2 Vein A Footwall
P % Vein A Pinch Outs Footwall
P i Vein &
P i Vein A Pinch Outs
P 7 Vein A Reference Surface
¢ Vein A Boundary [empty]

=P
(i

5. Add the hangingwall and footwall points (%) to the scene.
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6. Click the Show legend button (&) for the footwall points:
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The other veins interact with Vein A as follows:
« Veins B and D terminate against Vein A on Vein A's hangingwall side.
« Vein C terminates against Vein A on Vein A's footwall side.

Now we can set the interactions for the vein system.
7. Double-click on the vein system in the project tree.
8. Click on the Vein System tab:

& Edit Vein System

Lithology Vein System

Vein priority

[ Veins

WVein A
Vein B
WVein C

Vein N

good

Name: |Veins Vein System ]

The veins appear in the Vein priority list in the order in which they were defined. Because Vein A
is already at the top of the list, we don't need to change the order.

Vein Ais the highest priority vein in the list, and so no interactions can be set for it.
9. Clickon Vein B and click the Add button.
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Only veins that are higher in priority than the selected vein will appear in the Vein list, so the
correct vein has been selected. The Side is also correct:

& Edit Vein System

Lithology | Vein System

Vein priority

[] Veins
[ VeinA

[ VeinB

[0 VeinC

[l \eimn
Interactions of Vein B
Interaction Type  Vein

Terminates against Vein A

+£dd == Remove

Side
Hanging wall

Higher

Lower

3

Name: lVainsVein System

) Help

%Qancal

ok

10. Click on Vein C, then on the Add button.
11. Select "Foot wall” for the Side:

& Edit Vein System

Lithology | Vein System

Vein priority

[] Veins

[ Veina
[] VeinB

[0 VeinC

o Veim R

Interactions of Vein C

Interaction Type  Vein

+gdd == Remove

Side

Terminates against Vein A | v | Hanging wall

Hanging wall

Foot wall l,\\s

*
Higher

Lower

4

Name: lVainsVein System

l

) Hep

12. Click on Vein D, then on the Add button.

Again, the default interaction is correct.

13. Tick the box for each vein to enable them in the vein system, then click OK.

14. Clear the scene.
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15. Add the vein system to the scene:

¥ | B8 Projects ﬂicene\’\ew‘

& o W R F M-

DY s @ &

st (%)

+1472900

zimuth 015
o 100 200 300

|d>~'i-VeJhs~sbe...inSystem x & Litholo... - || R J% B ?‘ ~4¢ Veins Vein System

The vein system appearsin the scene as a single lithology.

If all four veins do not appear in the scene, it is likely that the interactions have not been set
correctly. If thisis the case, the affected vein will appear in the project tree as empty:

¥ (7 Vein system GM
g Boundary
&35 Fault System
P =5 Lithalogies
v @ Surface Chronolegy
¥ ~5 Veins Vein System [inactive]
P (9 Vein A
P 5 VeinB
[ 4 Q‘_; Vein C [empty]

2% Vein D

i
B [ Output Volumes

Double-click on the vein or the vein system to correct the interaction. Here, double-clicking
on the vein opens the Edit Vein window:

& Edit Vein C

‘ Interactiens | Surfacing  Inputs

Interactions of Vein C

Interaction Type  Vein Side
| Terminates against Vein A : Hanging wall :
Hanging wall
Foot wall Ik
.+Add f |

MName: [Vem C ]

;7mﬂelp | :7x£ance\ @QK
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Enabling the Vein System in the Model

Although the vein systemis now complete, we still need to enable it in the model.
. Double-click on the Surface Chronology.

. Enable the vein system and click OK.

. Clear the scene.

. Add the output volumes to the scene.

. Press the D key to view the scene from above.

. Click the Show slicer button (™).

. Click on the slicer in the shape list.

0o NOY U A WWNDN P

. Inthe shape properties panel, click on the Set to button and select Elevation (Z) Axis.

With the slicer tool selected, hold the Ctrl key and the right mouse button to change the
position of the slicer in the scene:

¥ | BB Projects [ Scene View
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Because we haven't defined the lithologies outside the vein system, lithology “Unknown” is
used. Compare the vein system with the individual veins modelled as part of the GM model.
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Tutorial 3: Modelling a Syncline in a Series of
Deposits

In this tutorial, we will use drillhole data to build a model of a syncline in a banded iron
formation. Whereasin we modelled the contact surfaces
individually, for this tutorial, we will model a series of deposits using a stratigraphic sequence.

Data for this tutorial can be found in the Syncline folder.

Setting Up the Project

To start:
1. Launch Leapfrog Geo.
2. In the Projects tab, click New Project.

3. Enterthe name "Syncline tutorial” for the new project and click Browse to select a folder
where the project will be saved.

4. Click OKto create the project.

The project will be created and Leapfrog Geo will display the Scene View tab for that project.

Importing a Photo and Setting the Clipping Boundary
First, we will import an aerial photo and use it to set the clipping boundary. Thefileis called
“photo.tif".

1. Right-click on the GIS Data, Maps and Photos folder and select Import Map.

2. In the window that appears, select the file called photo.tif, then click Open.

3. Click Import to import the photo.

4. Add the photo to the scene and press the D key to view it from above.

5. Right-click on the Topographies folder and select Set Clipping Boundary.
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6. From the Enclose Object list, select <Everything>:
R
Fluw-WNFE-[L\NES a &

North (Y) f

+203000

@ Set Clipping Boundary =

Clipping Boundary

Minimum Maximum
X (Fast): 053200 3] (024000 [3]
¥ (Northy: (1976000 2| [20m000 |3

Enclose Object v
<Everything>
@ Help X Canc

7. Click OK.

Importing the Drillhole Data

Data for this part of the tutorial can be found in the Syncline > Drillholes folder. There are three
files:

« collar.csv contains the collar definitions.
« survey.csv containsinformation that describes the deviation of each drillhole.
« geology.csv contains the interval definitions that describes the lithology.

1. Right-click on the Drillhole Data folder and select Import Drillholes.
The Import Drillhole Data window will be displayed.

2. For Collar, click on the Browse button to locate the tutorial file collar.csv.
3. Click on thefile, then click Open.

All files have been added to the Input Files list.

4. Click on Import to start the process of importing data.

5. Leapfrog Geo correctly maps the data in the collar and survey files, so click Next for each
one.

6. For the geology table, click on Finish to complete the process.
The data tables will be added to the project tree.
Now that we have imported the drillhole data, we can use it to create the topography.

© 2018 Seequent Limited



54 | Leapfrog Geo Tutorials

Creating the Topography

In , we created the topography from an elevation grid. For this
tutorial, we have no topography data, so we will use the collar pointsin the drillhole data.

A key advantage of defining a topography is that it provides consistent elevation data for
objects imported to and created in the project. The quality of elevation information can be
poor compared to X- and Y-coordinates, which can create problems when using objects to
build a model. Atopography can be created from the most reliable elevation data, and other
objects can have elevation set from this topography.

1. Right-click on the Topographies folder and select New Topography > From Points.

All points object available in the project will be listed, which, in this case, is only the imported
collar points:

& Select Points To Add X

v Il

] collar

£ Help 88 cancal ok

2. Click OK.

3. In the New Topography window, click OK to accept the default name and create the
topography.

Analysing the Data

Once Leapfrog Geo hasimported the data, we can view it and analyse it to make decisions on
how to build the geological model.

1. Click on the Clear scene button (¥) to clear any objects from the scene window.
2. Add the geology table to the scene.

3. Click the Make lines solid button (+) to display the drillholes as cylinders.

4. Adjust the Line radius in the shape properties panel, if required.

5. Click the Show legend button (=) for the table.

6. Zoomin to get a better view of the data.
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The scene should appear similar to this:

v | B3 Projects [ Scene View |

Flo-WNSBE-[JN\ &7 @ o

Lithology ]
Granite . Middle Shale
.Grava\ .Sandstone
Lower Banded Iron Formation Upper Banded Iron Formation
-Lower Basalt Upper Basalt
. Lower Carbonate Upper Carbonate
Lower Shale Upper Shale
[ middle Basalt

\R"

East (X)

+201000
= —
000 o ———

e

Plunge +20 @
Azimuth 030

0 500 1000 1500 2000

+2001
+199

500

@ eolo Litholo... - || Edit Colours (AN
Aealody geology
Slice mode: [Frum Scene -
Query filter Mo Filter v
Line radius: [SD.DD

The lowest layer in the model is Granite, which we can model as a deposit, and the highest layer
is Gravel. Although we could model the deposit contact surfaces one-by-one, the layers are
roughly continuous, which lends itself to modelling using a stratigraphic sequence. Therefore,
we will model the layers by defining a stratigraphic sequence that has Granite as the lowest
layer and Gravel as the highest.

Creating the Geological Model

To create the geological model:
1. Right-click on the Geological Models folder and select New Geological Model.
2. In the window that appears, change the following settings:

o Setthe Surface resolution to 50.
« Fromthe Enclose Object dropdown, select the geology table.

3. Click OK to create the geological model.

The new geological model will be created in the Geological Models folder.

Defining a Stratigraphic Sequence

To create the stratigraphic sequence:
1. Right-click on the model’s Surface Chronology and select New Stratigraphy.
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2. In the window that appears, select Gravel for the Lithology Above and Granite for the
Lithology Below:

& New Stratigraphic Sequence

Chronalagy | Surfacing

Lithology Above: - Gravel v

Stratigraphic Lithologies:

Add Lithologies

Lithology Below: [ Granite -
Bottom Contact Type: |Deposit v

Surfaces avoid drillhole segments

Name: | Stratigraphic Sequence l

'J_;ﬂelp xgancel QBQK

3. Click the Add Lithologies button.
4. Click the Lithology box to select all the lithologies:
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5. Click OK.
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The lithologies have been added to the Stratigraphic Lithologies list:

@ MNew Stratigraphic Sequence

Chronology ‘ Surfacing

rtogy e Wm0

Stratigraphic Lithologies:
I:l Upper Banded lron Formation
[ Middie Shale

I:l Upper Carbonate
I:l Lower Banded lron Formation

I:l Lower Shale

I:l Upper Basalt
1

Fark,

Livlogy B (G|
Bottom Contact Type: -
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W]

Name: [Stratigraphic Sequence ]

o [ |

6. Click OK.
7. Clear the scene.
8. When Leapfrog Geo has finished generating the stratigraphy, add it to the scene:

v | B2 Projects | [ Scene View |
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9. Expand the stratigraphic sequence in the project tree:

¥ [ Geological Models =
v (¥ oM
P @ Boundary
B3 Fault System
P = Lithologies
¥ @ Surface Chronology
v 3 Stratigraphic Sequence [inactive]

P % Upper Shale - Gravel Contacts
P> @ Upper Banded Iron Formation - Upper Shale Contacts
P & Middle Shale - Upper Banded Iron Formation Contacts
P i Upper Carbonate - Middle Shale Contacts
P & Lower Banded Iron Formation - Upper Carbonate Contacts
P @ Lower Shale - Lower Banded Iron Formation Contacts
P & Upper Basalt - Lower Shale Contacts
P & Lower Carbonate - Upper Basalt Contacts
P & Middle Basalt - Lower Carbonate Contacts
P /% Sandstone - Middle Basalt Contacts
P & Lower Basalt - Sandstone Contacts
P & Granite - Lower Basalt Contacts

B [ Output Volumes

The stratigraphic sequence object contains its own series of contact surfaces that can be
worked with in the same manner as contact surfaces that are created one-by-one.

If there were errorsin the sequence, it would include a set of points that can be used in fixing
the errors. For example, here the stratigraphic sequence has errors, which appear in the project
tree as a pinch-out errors object (%):

¥ @ Surface Chronelogy
W £F Stratigraphic Sequence [inactive]
#* Coarse Sand - Alluvium Contacts
% Gravel - Coarse Sand Contacts
> % Glacial Till - Gravel Contacts
B % Lower Gravel - Glacial Till Contacts
P # Aquifer Miocene Alluvium - Lower (
B # Basement Granite - Aquifer Miocene
P [ Output Volumes

These errors usually occur because a layer is not continuous, whereas Leapfrog Geo expects
that layersincluded in a stratigraphic sequence are continuous. Adding the pinch-out-errors
object (") to the scene displays the points that are causing errors. You can also find out more by
right-clicking on the stratigraphic sequence and selecting List Errors:

& Stratigraphic Errors

Pinch-out Errors

The following lithologies are discontinuous and should be removed from the stratigraphic sequence

Ignored  Invalid Contacts Pinch-out Lithology

] 'Alluvium' touches 'Gravel' 6 times Coarse Sand

O ‘Lower Gravel' touches 'Basement Granite' 1times Aquifer Miocene Alluvium
Other Errors

Ignored  Error Message

O ‘'Coarse Sand' does not contact 'Gravel'

;; Help ‘%Qancel {:ﬂgK

Together with the pinch-out errors, thisinformation can be used to decide what lithologies to
remove from the sequence or what surfaces to adjust.

However, for this tutorial there are no errors, and we can move on to the next step.
The sequence is not yet enabled in the model.
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10. Double-click on the Surface Chronology object.

11. Tick the box for the stratigraphic sequence to enable it:

& Geological Model - GM

Contact surface chronclogy

[] Contact surface

% £F stratigraphic Sequence

Background lithology: ll:l Unknown | v ‘

= o | [ |

12. Click OK.
13. Clear the scene.
14. Add the model's output volumes to the scene:
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Adding a Fault to the Model

The data for this tutorial includes a GIS line for a fault. We will now import the GIS line and add
the fault to the model.

1. Right-click on the GIS Data, Maps and Photos folder and select Import Vector Data.
2. In the window that appears, select the Fault.shp file and click Open.

3. Inthe window that appears, click OK.

4. When prompted to filter data, select the Don't Filter Data option.

The line will be imported to the project:
o Theimported lineisadded to the GIS Data, Maps and Photos folder.

o Acopy of thelineisdraped onto the topography and added to the Draped GIS Objects
folder in the Topographies folder.

Now we can add the fault to the geological model’'s Fault System.

Each geological model is created with a Fault System object that is used to construct faults and
manage their interactions. Once the faults are active in the geological model, the geological
model will be divided into separate fault blocks, which will appear in the project tree as part of
the model.

5. Right-click on the geological model’s Fault System and select New Fault > From GIS Vector
Data.

Two options are given for using the fault GIS line. Using the (On Topography) option makes

sense for GIS data asitis, by nature, on the topography. The (On Topography) option also

mitigates any issues that may occur if elevation information in the GIS data object conflicts with
that in the project.

6. Select "Fault (On Topography)” and click OK:

@ Select Vector GIS To Add

GIS Vector
Y&
h =]
44 Fault (On Topography)
h=]

Fault

Fault Type
(® Surface () Vertical Wall

The GIS line will be added to the Fault System but is not activated in the geological model.
7. Double-click on the Fault System.

In the Fault System window, all faults defined for a model are listed and you can set
interactions between these faults. For this model, however, there is only one fault and no
interactions need to be set.
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8. Tickthe box for the fault and click OK:

# Geological Model - GM

General

EBoundary Fault System | Lithologies

Fault system chronclogy:

[] Faults
% Fault (On Topagraphy)

I Heip |
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9. Once the geological model has been reprocessed, add it to the scene:

East ()

Plunge +35 e
Azimuth 037

1000 2000 3000

Note that the way the geological model is organised in the project tree has changed now that

the fault has been activated:

¥ [ Geological Models

v (¥ cm
P @ Boundary
P &5 Fault System
> E_E‘ Lithologies
¥ £ cMfault block 1
P (@ Fault Block Boundary
¥ @, Surface Chranalogy
> 5 Stratigraphic Sequence
P [ Output Volumes
¥ ) M fault block 2
P> (@ Fault Block Boundary
v @ Surface Chrenology
> 5 Stratigraphic Sequence
P [ Output Volumes
P [ Output Volumes

The geological model has been split into two fault blocks. Each fault block has its own Surface
Chronology, whereas the top-level geological model has none. The Surface Chronology for

one fault block can be modified without affecting other fault block.
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For geological models with a fault system, you can model the contact surfacesin two ways:

« Define the Surface Chronology before enabling the Fault System. All surfaces defined for
the unfaulted model will automatically be copied to each fault block. Some surfaces defined
for the model as a whole will not occur in every fault block, which can be corrected by
working with the surfacesin each fault block.

o Enable the Fault System before any surfaces are defined in the unfaulted model, then define
the Surface Chronology for each fault block. An aid to working with a faulted model in this
way is the ability to copy contact surfaces from one faulted block to another. To copy a
Surface Chronology from one fault block to another, right-click on the chronology you
wish to copy and select Copy Chronology To.

Which approach is best depends on the model being built. You may already know where the
faults are and choose to define them and subdivide the geological model before defining any
lithology layers. On the other hand, sometimes it is not apparent where the faults are until the
layers have been built, in which case you can add the new fault, activate itin the model, then
work with the surfacesin each fault block.

When working with fault blocks, it can be useful to rename them. For this model, we will
rename the fault blocks “north block” and “south block”.

10. Clear the scene.
11. Right-click on the geological model in the project tree and select View Fault Block

Boundaries.
12. Click on one of the fault blocks in the scene:
¥ | BB Projects | G Scene View
&: Luukv@&ﬂ[ﬁvl}|&jﬁf ﬂ‘l}
g
@ GM fault block 2: Fault Block &
Boundary
Location 99074.2837, 197900.0000,
153697
Volume 35,049,000,000
Area 73,986,000 Plunge +20 @
Parts ] Azimuth 030
0 1000 2000 3000
&Addgnmmants e —
@ (@ GMfault blo.kBoundary 3% (& Flat col...~ | I b () Fault Block Boundary
@ (3 GM fault bio..k Boundary  $8 [& Flat col..»|] ] P =| o [me P~ =

The name of the fault block is shown in the scene selection window.
13. In the project tree, find the fault block.
14. Right-click on the fault block and select Rename.

15. Enter the new name and click OK.
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Tutorial 4: Modelling a Complex Intrusion

In this tutorial, we will model a system of complex intrusions, which are shown in cross section
below:

GM

. Acid leached zone . Chiloritic alteration . Propylitic alteration
] Advanced argillic alteration [] Mineralised potassic alteration B sericitic alteration
D Basement l:| Porphyry stock l:| Volcanic edifice

When a geological model is first created, it is a single volume of lithology “Unknown”. This
Unknown volume is divided up into known lithologies by creating contact surfaces. Contact
surfaces interact with other surfaces in different ways, and understanding how the contact
surfaces interact helpsin making decisions on how to model formations.

Types of contact surfaces are:

o Deposit contact surfaces. These do not cut older volumes. A volume defined by a deposit
contact surface will, therefore, appear conformably on top of older volumes.

« Erosion contact surfaces. These remove lithologies on the older side of the erosion contact
surface.

« Intrusion contact surfaces. These remove existing lithologies and replace them with the
intrusive lithology on the younger side of the contact surface. Often, the older side of an
intrusion contact surfaceis labelled “"Unknown” as typically intrusions remove multiple older
lithologies.

« Vein contact surfaces. These remove existing lithologies and replace them with the vein
lithology within the boundaries defined by hangingwall and footwall surfaces and points
and a reference surface.
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Here, three deposit contact surfaces interact with two intrusion contact surfaces. The intrusion
contact surfaces are white (Unknown lithology) on the outside and the intrusive lithologies (11
and [2) on the inside:
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Intrusion contact surfaces result in rounder shapes than deposit and erosion contact surfaces,
which tend to be flat and sheet-like.

The difference between deposit and erosion contact surfacesis how they interact with older
lithologies.

o Depositsappear conformably on top of underlying older volumes and do not occurin
regions defined by older deposits.

« Erosions, however, remove existing lithologies on the older side of the erosion.

Here, two deposit contact surfaces divide a model volume (bounded by the pink box) into three
lithologies; each deposit (A, B and C) lies conformably on top of the previous one:

GM a
A
B

B

| [

| [

Unknown

When a third deposit contact surfaceisadded, lithology D is deposited on top of lithologies B
and C:

GM 5]
A
B

B

| [

| E

Unknown
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If, however, the third surface is an erosion contact surface, it cuts away the deposits on the older
side:

GM =]
A

B
[ [
| [
B-

Unknown

An intrusion contact surface enabled in the model will remove the existing lithologies and
replace them with the intrusive lithology. Here, an intrusion surface (E) added to the model as
the youngest surface cuts away the older lithologies wherever it occurs:

& Geological Model - GM oM =
A
General Boundary Fault System  Litholegies | Chronology .2
Contact surface chronology .D
Contact surface .E

Unknown
M Unknown - E contacts

# C-D contacts
# B - C contacts
& A - B contacts

Itis not necessary to model geological formations according to their corresponding contact
surface type. Often, the way you model a contact surface depends on the shape suggested by
the data and your knowledge of the geology of the area being modelled.

See the topic in the Leapfrog Geo online help for more information on the
different types of contact surface and how they interact.

Setting Up the Project

Data for this tutorial can be found in the Intrusion folder.
To start:

1. Launch Leapfrog Geo.

2. In the Projects tab, click New Project.

3. Enter the name “Intrusion tutorial” for the new project and click Browse to select a folder
where the project will be saved.

4. Click OKto create the project.
The project will be created and Leapfrog Geo will display the Scene View tab for that project.
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Importing a Map and Setting the Clipping Boundary

First, we willimport a map and use it to set the clipping boundary. The file is called map.tif.
1. Right-click on the GIS Data, Maps and Photos folder and select Import Map.

2. In the window that appears, select the file called map.tif, then click Open.

3. Click Import to import the map.

4. Add the map to the scene and press the D key to view it from above.

5. Right-click on the Topographies folder and select Set Clipping Boundary.

6. From the Enclose Object list, select <Everything>:
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7. Click OK.

Creating the Topography
Asin . we will create the topography from an elevation grid. The file
is called oamaru.asc.

1. Right-click on the Topographies folder and select New Topography > Import Elevation
Grid.

2. Navigate to the folder that contains the oamaru.asc file and open the file.
3. In the Import Elevation Grid window, click Import.

4. In the New Topography window, click OK.
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Importing the Drillhole Data

Data for this part of the tutorial can be found in the Intrusion > Drillholes folder. There are three
files:

« collar.csv contains the collar definitions.
« survey.csv containsinformation that describes the deviation of each drillhole.
« geology.csv contains the interval definitions that describes the lithology.

1. Right-click on the Drillhole Data folder and select Import Drillholes.
The Import Drillhole Data window will be displayed.

2. For Collar, click on the Browse button to locate the tutorial file collar.csv.
3. Click on thefile, then click Open.

All files have been added to the Input Files list.

4. Click on Import to start the process of importing data.

5. Leapfrog Geo correctly maps the data in the collar and survey files, so click Next for each
one.

6. Forthe geology table, click on Finish to complete the process.

The data tables will be added to the project tree.

Analysing the Data

Once Leapfrog Geo hasimported the data, we can view it and analyse it to make decisions on
how to build the geological model.

1. Click on the Clear scene button (¥) to clear any objects from the scene window.

2. Add the geology table to the scene.

3. Click the Make lines solid button (%) to display the drillholes as cylinders.

4. Click the Show legend button (¥)) for the table.

5. In the shape properties panel, increase the Line radius to make the drillholes more visible.

6. Zoomin to get a better view of the data.
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The scene should appear similar to this:
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The drillholes away from the centre of the data have two lithologies, Basement and Volcanic
edifice. These are the lowest layers in the model and we will model them as deposits.

7. Click the Edit Colours button.

8. In the Legend window, hide the Basement and Volcanic edifice lithologies:
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9. Click OK to dismiss the window.

10. Press the E key to view the scene looking east.
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The two lithologies are hidden in the scene and it is easier to view the drillholes at the centre of
the data. Note that the legend in the scene has been updated to reflect the hidden lithologies:
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From oldest to youngest, the lithologies are:
« Propylitic alteration

« Mineralised potassic alteration

« Porphyry stock

« Sericitic alteration

« Chloritic alteration

« Advanced argillic alteration

« Acid leached zone

11. Click the Edit Colours button.

Plurige 00
Looking East

100 200 300

Keep the Legend window open and move it away from the scene window to view different

lithologies in the scene.
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12. In the Legend window, hide lithologies so that only the Propylitic alteration, Mineralised
potassic alteration and Porphyry stock lithologies are visible:
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The propylitic alteration, mineralised potassic alteration and porphyry stock lithologies are
concentrated at the centre of the data. Because the drillhole data suggests a rounder shape for
these lithologies, we will model them as intrusion contact surfaces. These lithologies are
approximately the same age, but when we add them to the Surface Chronology, we need to
decide on an order. We can work from the outer edges of the model in, which isin the following
order:

« Propylitic alteration

« Mineralised potassic alteration
o Porphyry stock
The remaining lithologies are:

« Sericitic alteration

» Chloritic alteration

« Advanced argillic alteration

« Acid leached zone
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13. In the Legend window, hide lithologies so that the Acid leached zone, Advanced argillic
alteration, chloritic alteration and sericitic alteration lithologies are visible:
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These four lithologies are flatter and appear in more drillholes than the earlier intrusions, and
we can model them using deposit or erosion contact surfaces.

We will build this model by:
« Modelling the earliest lithologies, basement and volcanic edifice, as deposits.

« Modelling propylitic alteration, mineralised potassic alteration and porphyry stock lithologies
asintrusions.

« Modelling the remaining lithologies as a series of deposits and erosions.

Creating the Geological Model

To create the geological model:
1. Right-click on the Geological Models folder and select New Geological Model.
2. Inthe window that appears, change the following settings:

« Setthe Surface resolution to 20.
o Tickthe box for Adaptive.
« Fromthe Enclose Object dropdown, select the geology table.

3. Click OK to create the geological model.
The new geological model will be created in the Geological Models folder.
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Modelling the Deposit Contact Surfaces

In . we saw that the oldest lithologies in the drillhole data are two deposits:
« Basement
« Volcanic edifice

The first contact surface we will create is the Basement contacts.
1. Clear the scene.

2. Right-click on the Surface Chronology object and select New Deposit > From Base
Lithology.

3. Inthe window that appears, select “Basement” from the Select primary lithology dropdown
list.

We want to build a surface that represents the contacts between Basement and Volcanic
edifice and that excludes younger lithologies.

4. Drag the Sericitic alteration contacts and the Propylitic alteration contacts to the Ignored
lithologies list:
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To select multiple items in windows and in the project tree, hold the Ctrl key or the Shift key
while clicking.

5. Click OK.

The new contact surface will appear in the project tree under the Surface Chronology.
6. Add the geology table to the scene.
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7. In the shape list, click the Edit Colours button for the geology table.

8. Hide all lithologies except Basement and Volcanic edifice.

9. Add the new contact surface to the scene and rotate the scene to view the drillholes and the

surface:
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Note that Leapfrog Geo has labelled the surface as Basement on the underside (the older side)

and Volcanic edifice on the top side (younger).
10. Clear the scene.

11. Double-click on the Surface Chronology.
12. Tick the box to enable the contact surface:
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General Boundary Fault System  Lithologies | Chronalogy

Contact surface chronology

Contact surface
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i 3
Younger
Qlder
Background lithology: [ Unknown -

el

13. Click OK.
14. Once the changes have been processed, add the model to the scene.
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The contact surface has divided the Unknown volume into known lithologies Basement and
Volcanic edifice:
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Modelling the Intrusions

The next step is to model the propylitic alteration, mineralised potassic alteration and porphyry
stock lithologies. As discussed in Analysing the Data, we will work from the outer edges of the

model inward:

o Propylitic alteration
« Mineralised potassic alteration
o Porphyry stock

1. Clear the scene.
2. Right-click on the Surface Chronology object and select New Intrusion > From Base
Lithology.
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3. Inthe window that appears, select Propylitic alteration:
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We need to move all younger lithologies into the Ignore (Younger lithologies) list. The easiest
way to do thisis to move all the lithologies into the Ignore (Younger lithologies) at once, then
add the lithologies we want to the Exterior lithologies list.

4. Clickin the Exterior lithologies list.
5. On the keyboard, press Ctrl+A.
6. Drag all lithologies into the Ignore (Younger lithologies) list.

The lithologies in the Exterior lithologies list should be those that the intrusive body cuts
through, which will be the older lithologies.

7. Double-click on Basement and Volcanic edifice to add them back into the Exterior

lithologies list:

8. Click OK.
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The new contact surface will appear in the project tree under the Surface Chronology.

9. Add the new contact surface (®) to the scene, together with the points (*#) and segments ()

used to create it.
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Itis coloured on the inside with the intrusive lithology and on the outside with the lithology
Unknown:
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This is typical of intrusive lithologies as they contact multiple other lithologies on the outside.

10. Repeat steps 2 to 9 for the Mineralised potassic alteration and Porphyry stock lithologies,
being sure to keep older lithologies in the Exterior lithologies list:

o Forthe Mineralised potassic alteration intrusion, the Exterior lithologies will be Basement,
Volcanic edifice and Propylitic alteration.

o Forthe Porphyry stockintrusion, the Exterior lithologies will be Basement, Volcanic edifice,
Propylitic alteration and Mineralised potassic alteration.

Itisa good idea to check each surface asis it created by adding the surface to the scene,
together with the data objects used to create it.
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11. Clear the scene.
12. Add all new intrusions to the scene:
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The Propylitic alteration appears geologically reasonable, but the other two surfaces do not.
We need to give them a more vertical appearance, and the best way to do this, in the absence of
additional data, isto apply a trend to the surface.

Often the easiest way to apply a trend is to position the moving plane in the sceneand useitasa
reference plane for the trend we will apply to a surface.

13. Remove the Propylitic alteration and Porphyry stock contact surfaces from the scene.
14. Press the E key to view the scene looking east.
15. Click on the Draw plane line button (#) in the toolbar and draw a line roughly vertical in the

scene:
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16. Rotate the scene to view the plane properly.
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17. Click on the plane to view its controls and reposition it, if you wish:

.'EEEijects [cheneViewi = 8 Alex| v
F ok WA (@ HE-ILKX\#S @ &

g g - 2

3 3 = 3 %
+ z e b 5

\ Plunge 00 o
Looking Morth
0 100 200 300
iJ Plane 3¢ {o 89.67/360.0°, pitch 180.0° ..
@ M GM: Mineral...ic alteration ® [&Litholo...~ l:“:l Do A

Plane Orientation  Centre Point

Dip:  [89.58 |5| | X [1440413.47596;
Dipaz (3600 |3| | Y: |5002053.93067 %
Pitch: 1800 -| Z [-31.214308700 %

Align movement handles to
@ Axes () Camera

18 @ Full Acceleration 80FPS  F7-Scale 1.0

We now need to apply the settings from the moving plane to the contact surface.
18. Double-click on the contact surface in the project tree.
19. Clickon the Trend tab.

20. Click the Set From Plane button to copy the plane settings:

@& Edit Mineralised potassic alteration
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This copies the moving plane settings to the Trend tab.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene,

where:

« The Maximum value is the relative strength in the direction of the green line on the moving

plane.

o Thelntermed. value is the relative strength in the direction perpendicular to the green line
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on the moving plane.
« The Minimum value is the relative strength in the direction orthogonal to the plane.

To emphasis the vertical trend, we can change the Intermed. value.
21. Set the Intermed. value to 6.

22. Click OK.
When the surface is reprocessed, it should appear similar to this:
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Now that we have adjusted the Mineralised potassic alteration surface, we can use the same
plane settings to adjust the Porphyry stock surface.

23. Clear the scene.

24. Add the Porphyry stock surface to the scene.

25. Double-click on the contact surface in the project tree.
26. Clickon the Trend tab.
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27. From the Set to list, select the trend settings used for the Mineralised potassic alteration
surface:
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28. Click OK.

Once the surface is reprocessed, it should appear similar to this:
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29. Clear the scene.
30. Double-click on the Surface Chronology.
31. Enable each of the intrusions and click OK.

32. Add the geological model to the scene.
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The model should appear similar to this:
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Modelling the Younger Alterations

In Analysing the Data, we saw that the younger alterations form relatively flat layers. In this
step, we will model them as deposit and erosion contact surfaces. The remaining lithologies are:

« Sericitic alteration

« Chloritic alteration

« Advanced argillic alteration
» Acid leached zone

We will model these lithologies using alternating erosion and deposit contact surfaces. First, we
will model the Sericitic alteration contacts as an erosion.

1. Right-click on the Surface Chronology object and select New Erosion > From Base
Lithology.
2. Inthe window that appears, select Sericitic alteration.

3. Click Use contacts below.
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The younger lithologies should automatically appear in the Ignored lithologies list:
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4. Click OK.

5. Clear the scene.

6. Add the new surface to the scene.
It should appear similar to this:
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Next, we will enable the surface in the model.

7. Double-click on the Surface Chronology and enable the Sericitic alteration contacts surface.
8. Click OK

9. Clearthe scene.
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10. Add the geological model to the scene:
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Next, we will create a deposit contact surface for the Chloritic alteration lithology.

11. Right-click on the Surface Chronology object and select New Deposit > From Base
Lithology.

12. In the window that appears, select Chloritic alteration.
13. Click Use contacts below.

14. Move all lithologies into the Contacted/Avoided lithologies list except Acid leached zone
and Advanced argillic alteration, as these are younger than the surface we are defining:
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For some of the lithologies we have included in the Contacting/Avoided lithologies list, there
are no contacts with the Chloritic alteration lithology. However, if the drillhole data is updated,
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there could be contacts between Chloritic alteration and these other lithologies. Because

Chloritic alteration isyounger than these other lithologies, we need to move these lithologies
into the Contacting/Avoided lithologies list.

15. Click OK.
16. Clear the scene.
17. Add the surface to the scene:
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18. Create an erosion contact surface for the Advanced argillic alteration lithology using these
settings:

« Select the Use contacts below option.

« Remove all lithologies except Acid leached zone from the Ignored lithologies list.

It should appear similar to this:
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19. Right-click on the Surface Chronology and select New Deposit > From Base Lithology.
20. Select Acid leached zone as the primary lithology and select Use contacts below.
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As with the Advanced argillic alteration contact surface, there are older lithologies for which
there are no contacts with the primary lithology. However, updating the drillhole data could
result in contacts between these younger lithologies and the primary lithology and we would
wish the model to reflect this. Therefore, we need to move older lithologies into the
Contacting/Avoided lithologies list.

21. Move all lithologies into the Contacted/Avoided lithologies list.

22. Click OK.

The surface should appear similar to this:
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23. Double-click on the Surface Chronology.
24. Enable all the contact surfaces and click OK.
25. Clear the scene.

26. Add the model to the scene.

It should appear similar to this:
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Tutorial 5: Building a Geological Model From a
Map

In this tutorial, we will create a geological model from an imported map using GIS lines and
structural data.

Data for this tutorial can be found in the Map folder.

Setting Up the Project

To start:
1. Launch Leapfrog Geo.
2. In the Projects tab, click New Project.

3. Enterthe name "GM from map” for the new project and click Browse to select a folder where
the project will be saved.

4. Click OKto create the project.
The project will be created and Leapfrog Geo will display the Scene View tab for that project.

Importing a Map and Setting the Clipping Boundary

First, we will import a map and use it to set the clipping boundary. The file is called Simple fault
and sediments.tif.

1. Right-click on the GIS Data, Maps and Photos folder and select Import Map.

2. In the window that appears, select the file called Simple fault and sediments.tif, then click
Open.

3. Click Import to import the map.
4. Add the map to the scene and press the D key to view it from above.
5. Right-click on the Topographies folder and select Set Clipping Boundary.
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6. Adjust the red handles so the clipping boundary matches the map’s border:

;Lookvw\@mv@\\géy @ O

MNorth (Y) f

+5EEA,

& Set Clipping Boundary

Clipping Boundary
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X (East: (3300

¥ (North): [57.0

S
Lepking down
1

] 2000 3000

E

— ! &F Simple fault and sediments

7. Click OK.

Creating the Topography

Asin Tutorial 2: Modelling Veins, we will create the topography from an elevation grid. The file
is called topo.asc.

1. Right-click on the Topographies folder and select New Topography > Import Elevation
Grid.

2. Navigate to the folder that contains the topo.asc file and open the file.
3. In the Import Elevation Grid window, click Import.
4. In the New Topography window, click OK.

Creating the Geological Model

To create the geological model:
1. Right-click on the Geological Models folder and select New Geological Model.
2. Inthe window that appears, click OK to accept the default settings and create the model.

The new geological model will be created in the Geological Models folder. Because thereisno
drillhole data in the project, we need to manually define the lithologies used in the model.

3. Double-click on the Lithologies object.
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4. In the Lithologies window, click the Add button to add a lithology:

& Geological Model - GM

General Boundary Fault System ‘ Lithologies | Chronology
Code Colour
Unknown l:l

| & ] | | |
| Eﬁﬂelp J . xgancel 1 @QK |

5. Name the lithology Red.
6. Add two more lithologies, Blue and Green.

7. For each lithology, set the colour to match those in the map by clicking on the colour chip,
then using the eyedropper to pick the colour from the map displayed in the scene:

- [ Bl oo
&Lookvwx@[ﬁv@;\\géy ﬂlﬁ

@ Geological Model - GM X

General Boundary Fault System Lith°|°9ies‘chlanalogy

Code

Caolour
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e,

% Select Colour

/ .
Saturation: |

Colour name:
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[

&F Simple fault and sediments

.==...= % Slice mode: | From Scene | v:‘

| ﬁﬂe\p | ‘ Random H &gancel H @QK |

8. Click OK to close the Lithologies window.

Creating the Fault

We will create the fault by drawing a GIS line and structural data pointsin the scene.
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1. Clearthe scene.
2. Add the topography to the scene.

3. From the GIS data dropdown list, select the imported map from the Maps and Photos
submenu to view it draped on the topography:

@ 4 Topography 3¢ |& Flat col..~ l:l —— ] B
GIS data: | Select |
Mone
Views 3
Maps and Photos ] Simple fault and sed\mentsll\\?

4. Right-click on the GIS Data, Maps and Photos folder and select New GIS Line > From New
Drawing.

5. In the window that appears, name the line "Fault”.

The new GIS line will be created in the project tree and will be added to the scene. Drawing

tools will be added to the scene window, and the slicer will be added to the scene to give the

drawn GIS line depth:
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b |59 Full Acceleration 4FPS  Z-Scale 1.0

6. To startdrawing, click on the Draw lines button ().
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A set of tooltips appearsin the scene:

Aot L L-NER Y X4V
CuFault x
Start 2D Line

« Click to start a new 2D line.
« Drag to start line and set curvature.

North (Y)

7. Follow the tooltip instructions to trace the fault in the scene:

v | B3 Projects ijCEnE\c’iew| "5 Alex R
Flo- WA/ EB- 3\ & 75 @ &
2 Foutt b 4 Select v : s

Dragging Curvature
» Release to set curvature,

= Slicer B OumEo D %, Sticer
@ A Topography ® @Fatcol- ][ [V —— Db S
Gl data: — ) Shce it @ %) Location | setto v |
® % Faukt [Empty] [Editing] % 3¢ (DD ——— | stepsizer [9000 |2 [ =] x [1o0000 |3

8. Right-click to end the drawing of the fault, then click the Save button.
9. Remove the GIS line and the slicer from the scene.
Next, we will add the fault to the geological model, then edit it with structural data points.

10. Right click on the Fault System for the geological model and select New Fault > From GIS
Vector Data.

When the Fault Type is set to Surface, the drawn GIS line will appear in the list twice. The Fault
(On Topography) option automatically drapes the drawn GIS line on the topography.

11. Select the Fault (On Topography) object and click OK.
12. Expand the Fault System in the project tree to see the new fault.
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13. Right click on the fault and select Edit > With Structural Data:
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A structural data table will be created and added to the project tree as part of the fault object.

The table will be added to the scene for editing and the structural data toolbar will appear,
together with the Structural Data window:
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14. Zoomin to one of the structural data points on the map.
15. Rotate the scene so that you are looking in the direction of the dip.
16. Change the plunge until it is about the same as the dip.
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17. Click on the structural data point button (**) and draw the data pointin the scene. Todo
this, click on the centre of the strike and dip, and drag to the right:
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Always drawing structural data points in the same direction ensures the polarities remain
consistent.

18. In the Structural Data window, manually enter the Dip value from the map:
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Show down dip lines

19. Draw the second structural data point that occurs along the fault and edit its dip value.
20. Click the Save button.

21. To enable the fault, double-click on the Fault System.

22. Tickthe box to enable the fault.

23. Click OK.
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The geological model has now been divided into two fault blocks, named "GM fault block 1"
and "GM fault block 2":

¥ [ Geological Models
¥ ¥ am
P @ Boundary
V &3 Fault System
P == Fault (On Topography)
H Lithologies 3
¥ ) GMfault block 1
P> @ Fault Block Boundary
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P [ Output Volumes
[ 3 E‘ Output Volumes

We can rename these volumes to make them easier to work with.
24. Clear the scene.

25. Right-click on the geological model in the project tree and select View Fault Block
Boundaries.

26. Press the D key to view the model from above.
27. Click on the eastern side of the geological model:
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This shows that the fault block on the east is “GM fault block 1".

28. Right-click on the fault block in the project tree and select Rename.
29. Rename the fault block "East”.

30. Rename the other fault block "West".

Creating the Contact Boundary Meshes

The contacts will be created using GIS lines. We could draw them from the map, as we did for
the fault, but for this step, we will import the GIS lines and use them to create meshes. We will
then edit each mesh using the structural data point for each contact boundary.
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1. Tostart, clear the scene.
2. Right-click on the GIS Data, Maps and Photos folder and select Import Vector Data.
3. Select the four shape files and click Open:

o blue_green_east.shp
o blue_green_west.shp
o red_blue_east.shp
o red_blue_west.shp

4. In the Import GIS Vector Data window, click OK.

5. Click Don't Filter Data.

The imported GIS lines will be added to the GIS Data, Maps and Photos folder.

Next, we will create four meshes, starting with the blue_green_east mesh.

6. Right-click on the Meshes folder and select New Mesh > From GIS Vector Data.
7. Inthe window that appears, select the blue_green_east (On Topography) GIS line.
8. Click OK to accept the other settings and create the mesh.

Next, we will add a structural data point to the mesh.

9. Add the topography to the scene.

10. Orient the scene to draw the structural data point along the blue_green_east boundary.
11. Right-click on the mesh and select Edit > With Structural Data:
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12. Zoomin to the structural data point on the map.

13. Click on the structural data point button (**) and draw the data pointin the scene.
14. In the Structural Data window, manually enter the Dip value from the map.

15. Click the Save button.

16. Repeat the above steps for each imported GIS line.

Adding the Contact Surfaces to the Geological Model

Now that we have created the GIS lines that represent the contact boundaries, we can start
adding contact surfaces to the geological model. The geological model has been divided into
two fault blocks, East and West, so we need to define the surface chronology for each fault
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block. We will do this working from the oldest contacts to the youngest, which means that for
each fault block we will define:

o« A Green-Blue surface
« ABlue-Red surface

1. Clear the scene.

2. Right-click on the Surface Chronology for the East fault block and select New Deposit >
From Surface.
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3. Inthe window that appears, select the blue_green_east (On Topography) mesh.
4. Set Blue for the First lithology.

5. Set Green for the Second lithology.

6. Ensure that First lithology is set to be younger than the Second lithology:

& New Depositional Contact x

Select surface
I blue_green_east (On Topography)

Select lithology

Eirst lithology: -Blue ¥ | lisYounger | v
Second lithology: -Graen w | is Older
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;; Help ‘%gan:el -QEQK

7. Click OK.

Once the surface has been created, we can add it to the scene to check its orientation.
8. Add the contact surface to the scene.

9. Add the topography to the scene.

10. Orient the scene to see whether or not the colours assigned to each side correspond to
those on the map.
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If the surfacesis not oriented correctly, as in the image below, click the Swap Younging
Direction button:
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11. Repeat these steps for each contact, creating the surfaces west of the fault using the
Surface Chronology for the west fault block.

12. Add the four surfaces to the scene. They should appear similar to this:
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If your results are not expected:

« Checkthatthe surfaces are oriented correctly and change the younging direction, if
required.

o Edit the structural data point used to edit each mesh. To do this, expand the mesh in the
project tree. Right-click on the structural data table and select Edit In Scene.

Enabling the Contact Surfaces

Although the contact surfaces have been defined, we still need to enable them.
1. Double-click on the Surface Chronology for the East fault block.
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2. Enable both contact surfaces and click OK.

3. Repeat the process for the West fault block.

4, Clear the scene.

5. Right-click on the geological model and select View Output Volumes:
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